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Overview

Overview

This guide presents year-end processing guidelines for Deltek Costpoint.

Note: See the Deltek Costpoint Frequently Asked Questions document for related information.

Adding Custom Notes to This Guide

If you would like to add custom notes to this guide that are specific to your company, Adobe® Reader® X
provides this ability. If you do not already use Adobe Reader X, you can download it here free from
Adobe.

To add a custom note using Adobe Reader X:

1. On the Reader toolbar, click Comment at the far right.

2. Inthe Annotations pane that displays, click Q Sticky Note. The cursor changes to match the
button.

3. Position the cursor at the location in the guide where you want the note to appear, and click. A
note icon is inserted at the location and a text box pops up.

4. Enter your information in the text box.
Continue adding notes as needed.

6. Save the document.

Note: Deltek recommends that you save the document to a slightly different filename so as to keep
the original from being overwritten.

When reading the document, cursor over a note icon to see the information. Double-click a note icon to
edit the information.

Deltek Support Center

To expedite our responses to your questions at year end, we encourage you to use the Deltek Support
Center, https://deltek.custhelp.com, where you can enter incidents on the Ask Support page or start a live
chat with one of our analysts.

Click the link below to view Year-End Resources, located on the Support Center home page. This site will
be updated continuously through February and will contain information such as Year-End Bulletins,
FAQs, links to the product releases, additional services that are offered for year-end, and up-to-date tax
changes.

You need a valid Deltek Support Center login to access this site:

https://deltek.custhelp.com/app/YearEnd

Alternatively, you can contact Deltek Customer Care by calling 1.877.457.7765.
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Chapter 1: What's New

Chapter 1: What's New
1099 Changes

There are no format changes to 1099s for 2018.

W-2 Form Changes

There are no format changes to the W-2 for 2018.

W-2 Box 12 Codes

The following Codes have been added to the Manage W-2s » Box 12 Lookup field:
= GG — Income from qualified equity grants under section 83(i).

= HH — Aggregate deferrals under section 83(i) elections as of the close of the calendar year

USERRA Codes

The following USERRA codes have been added to the Edit W-2 Information/Box 12 Lookup field:
= D17 — USERRA 2017 make up elective deferrals to a section 401(k) cash or deferred

arrangement.

= E 17 — USERRA 2017 make up elective deferrals to a section 403(b) salary reduction
agreement.

= F 17 — USERRA 2017 make up elective deferrals to a section 408(k)(6) salary reduction
agreement.

= G 17 — USERRA 2017 make up elective deferrals and employer contributions (including
nonelective deferrals) to a section 457(b) deferred comp plan.

= H17 — USERRA 2017 make up elective deferrals under a section 501(c)(18)(D) tax-exempt
organization plan.

= S 17 — USERRA 2017 make up employee salary reduction contributions under a section 408(p)
SIMPLE.

= Y 17 — USERRA 2017 make up deferrals under section 409A nonqualified deferred
compensation plan.

= AA 17 — USERRA 2017 make up designated Roth contributions to a section 401(k) plan.

= BB 17 — USERRA 2017 make up designated Roth contributions under a section 403(b) salary
reduction agreement.

= EE 17 — USERRA 2017 make up designated Roth contributions under a section 457(b) plan.

EFW2 Filing (Electronic Filing of W-2 Forms)

Multiple changes have been made to the Federal EFW2 for 2018 compliance.

State Electronic Filing

Various changes for multiple states have been made to the 2018 EFW?2 state electronic file.
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Chapter 1: What's New

Deltek

Federal Regulatory Updates

Please see the Release Notes for a full recap of all changes.

Product Changes

Please see the Release Notes for a full recap of all changes.
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Chapter 2: Ordering Forms

Chapter 2: Ordering Forms

For information about vendors that work with Deltek, complete the following steps to view the
vendor page on the Deltek Web site:

1. Go to htitp://www.deltek.com.

2. Click Partners.

3. Select Find a Partner, then select Product Partner Marketplace. Search for “Forms”. Then,
click Forms Fulfillment Center.
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Chapter 3: Accounts Payable Processing

Chapter 3: Accounts Payable Processing

1099 Tracking and Posting Checklist

Use the following checklist as you complete your year-end steps for 1099 tracking and posting.

1.

10.

11.

12.

13.

14.

15.

During vendor setup, designate vendors as 1099 Reportable on the Vendor
Info screen.

Enter vouchers (voucher lines or expense lines flagged as 1099 with 1099
type).

Post vouchers.
Print checks and post cash disbursements.

In December 2018: Install the Costpoint Calendar Year-End (CYE) Regulatory
Update.

Order 1099-MISC forms.
Create 1099 information for calendar year 2018.
Print the 1099 Edit Report.

Review the 1099 Edit Report to check the vendors’ Tax ID/Social Security
numbers.

Make necessary corrections in Costpoint, on the Manage Vendor History
screen.

Create 1099 information.
Print the 1099 Edit Report again to check your corrections.

Optional: Print 1099s on blank paper to review vendor addresses and
alignment.

Print 1099s.

Create the Magnetic Media File (to be transmitted electronically), if required for
your company.
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Manage Vendors Screen
To define the 1099-MISC type, go to the Manage Vendors screen and complete the 1099’s section.

% [0 Browse Applications > Accounling = Accounis Payable = Wendors > Manage Vendors

Identification Mew | Copy W | Desete 1 of 1 Existing Table | Query W [[] ™| X
Vendor ID 1099NON Name * 1099 NON EMPLOYEE Location
U Defaults  Notes
Long Name* (1099 NON EMPLOYEE Vendor Grou bl
L £l Y99 APLC L n
K4 Print 1099-MISC Form
Vendor Status Customer Account e
) Typa NONEMP  »
® Active [] Hold Payments )
. Tax ID 52-0223375
Give Waming [] Payroll Vendor s
Expense Class nd 99 N JF E
) Inactive Name 1099 NON EMPLOYEE
. DUNS Number
Password
CAGE Code
Subcontractor Managament
1 Vendor Employes ey
ub i 200 Cmpioyee = = = =
[ Suecorndmctr Approval Group i Usar DELTEK Date  06M2/2001 APPROVED
Vendor Employees  Vendor Classificafion  Cumencies  Subcontractor Info  Credift Card info  Addresses  Default Expense Accounts VATInfo  CiSinfo  User-Defined Info
identification > Addresses Mew | Copy W Delle Fom Cwery ¥ | [F| ™ | X
T Address || Address Adidress T Address State/ Postal | Ship ID Payment Oreder Phone  Fax ot
¥ code* Line 1 Line 2 Line 3 City Province Code Country  ShipiD | Description | Address | Address™ | Number Number Nur
BILLING ADDRESS LINE#1 |ADDRESS LINE#2 |ADDRESS LINE#3 |MCLEAN VA 522209 |UsA Default ¥ Mo Y |
4 ] 4|
Contacts EFTinfo (NMon-US} EFT Info (U S)
G|

The 1099-MISC type selected on the Manage Vendors screen defaults on every voucher line for that
vendor.

You can edit the 1099-MISC type:

= At the voucher line level on the Manage A/P Vouchers and Manage PO Vouchers screens

= On the Manage Vendor History screen

= On the Edit 1099 Information Screen
If you select the Print 1099-MISC Form check box, then the 1099 check box on the Enter A/P Vouchers
and Enter PO Vouchers screens defaults to selected on each expense line.

The Vendor 1099 Name prints on the 1099 and appears in the file created by the Create 1099s and
Magnetic Media screen.

The Payer Address Lines and Recipient Address Lines print in all uppercase letters.

Costpoint totals each 1099-MISC type for the selected calendar year and places totals in the appropriate
box on the 1099-MISC form (when printed).

The 1099-MISC report totals the 1099-MISC types by vendor.
The 1099-MISC types supported in Costpoint and their limits are summarized in the following table.
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Deltek

1099 Box | Description Limit Amount
Number

Costpoint
Code

Box 1 Rents $600 or more RENT
Box 2 Royalties $10 or more ROYAL
Box 3 Other Income $600 or more OTHER
Box 4 Federal Income Tax Withheld All amounts FED
Box 5 Fishing Boat Proceeds All amounts FISH
Box 6 Medical and health care payments $600 or more MED
Box 7 Non-employee compensation $600 or more NONEMP
Box 8 Substitute Payments in lieu of Dividends or interest  $10 or more DIVD
Box 9* Payer made direct sales of 5000 or more of $5000 or more SALE
consumer products to a buyer (recipient)
Box 10 Crop Insurance proceeds $600 or more CROP
Box 14 Gross proceeds paid to an attorney $600 or more GATT

* |If amounts recorded exceed 4,999.99, Costpoint prints an X in the box.

1099s Section of Manage Vendors

To maintain 1099 information:

1. Inthe Vendor 1099 Name field, enter the Vendor’s Tax ID name if it is different from the Sole
Proprietor in the Long Name field on the Manage Vendors screen.

1099's

Print 1093-MISC Form

Type INONEMP v

TaxID 52-0223375

1099 1099 NON EMPLOYEE
Mame

2. Select the Print 1099-MISC Form check box to track, create, and print 1099-MISC information
for this vendor. If you do not select this check box, a 1099 will not print for this vendor.

Selecting this check box affects the creation and printing of 1099s for this vendor and serves as a
default for the 1099 column and 1099-MISC Type column on the voucher line on the Manage A/P
Vouchers and Manage PO Vouchers screen.

3. Select the type of 1099 payments made to this vendor. This selection determines the type of
1099-MISC income that is the default for this vendor. The Type drop-down list includes some
1099 types that do not print on the 1099-MISC form:
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= A — Acquisition/Abandonment

= B — Broker and Barter

= DIV — Dividends and Proceeds

= G — Certain Government Payments

= INT — Interest Income

= OID — Original Issue Discount

= PATR — Taxable Distribution from Coop
= R — Retirement Distributions

You can flag the line with any of the 1099 types listed, but Costpoint does not support these 1099
types on a printed form.

Accounts Payable: Manage Accounts Payable Vouchers

* m Browse Applications > Accounling > Accounts Payable > Voucher Processing > Manage Accounts Payable Vouchers

Manage Accounts Payable Vouchers New Copy W | Delete | Amach Approval 1of 1 Existing Tathe | Cuary W Ol x
Identification Currencies
Voucher 24144 Fiscal Year™® 2039 l Period * ' Subperiod * ' Trans USD Pay USD
Vendor®  1099NON ) 1099 NON EMPLOYEE Terms  NET 10 ) B4 Approved 7] Tempiale Line Default |
GEEGEALI Details Address  Check  Recur Subcontractor Info  Notes/Doc Loc  Entry Defaults
Invoice Due
Number Date  09/05/2039 e Amount® 15,000.00 Date 09/15/2039 s
Discount Amount 15,000.00
Percent 0.00% Date 09052039 = Amount 0.00
Account Descriptions Voucher Type
AP AP 020001 ] Cash CASH 00111-010.1 ' AP Voucher
Voucher L

tribution Recalculation Method Recalculate Cost v Recalculate |

When Calculated Sales Tax is Changed Recalculate Tot Before Disc v Recalculate
Tolal Tax 0.00 Remaining Balance 0.00
Exchange Rotes  Voucher Totals
AJP Voucher Detail Mew | Copy W | Dalate | Form | Quey W ||
¥ TaxVAT Code TaxRate Sales’VAT Tax Amt Tot Before Disc  Discount  Total Amt  Use/Reverse Tax Amt Recovery Rate  Recovery Amt  Vendor 1099°'s | 1099 Type Description | Org Abbr
| 0.00 15,000.00 0.00| 15,000.00 0.00 0.00% 0.00 4 NONEMP PETTY CASH | STI
L4 - 3

Vendor Lshor  Currency Line  Customs Info

After the vendor has 1099 information in the 1099s section, the voucher lines for the vendor default to
selected in the 1099 column and the default 1099 type displays in the Type column.

Clear the 1099 column if that particular voucher line is not a 1099 reportable amount.

When you pay the voucher, Costpoint uses the lines designated as 1099 reportable in calculating the
1099 payments for this vendor.

Costpoint uses the check date when calculating 1099 amounts, which are based on the calendar year
(January 1 through December 31). If you posted a 1099 amount for a vendor in December 2018, but paid
the vendor in January 2019 (and the check is dated 2019), the 1099 amount is reported in the calendar
year 2019.
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Accounts Payable Utilities: Manage Vendor History

% [I Browse Applications > Accounfing > Accounts Payable > Accounts Payable Ulilities > Manage Vendor History

Maintain Vendor History Mew Copy W | Dalete 1 of 1 Existing Table | Guery W[ 7 ([ X
Identification Curmencies

Voucher No 24144 Fiscal Year* 2039 ) Perod* 1 Subperiod * 1 Trans  USD Pay USD

Vendor * 1099NON ) 1099 NON EMPLOYEE ] ) SeaNo 2

VEL R EI  Header Info  Address  Subcontractor Info Motes/Doc Loc  Recalculate Lines

Invoice Discount Due
Number Percent 0.00% Date 09/15/2039 |
Date 09/05/2039 Date 09/0522039 Amount 15,000.00
Amount 15,000.00 Amount 0.00
Total Tax 000  Remaining Balance 0.00 AP Voucher
Exchange Rates  Voucher Totals
Voucher line Mew | Copy W | Delete | Form Query W ||™
- 4 ) |
¥ | Taxabilty*  TaxCode Tax Rate | Sales/VAT Tax Amt Tot Before Disc  Discount  Total Amt  Use Tax Amt Recovery Rate Recovery Amt ] 1099 1099 Type | Org Abbrev  Proj Abbrev | |
None 0 OU%I 0.00] 15,000.00 0.00] 15,000.00 0.00 0.00% 000] & |NONEMP  |STI | | [
0 - -
Default Lines I

Vendor Labor Currency Line  Customs Info

Posted voucher information displays on the Manage Vendor History screen.

You can edit the 1099 check box and the 1099 Type column on this screen if you selected the Print
1099-MISC Form check box on the Manage Vendors screen.

You cannot edit voucher 1099 information on this screen if you have not set up the vendor to be a 1099
vendor on the Manage Vendor screen.

If you need to update the total 1099 amount for a vendor after making changes or corrections on this
screen, go to the Create 1099 Information screen and run it again for that vendor.

Costpoint calculates the 1099 amounts by calendar year, based on the check date (month, day, and year)
and the check amount.

1099-MISC Processing

Create 1099 Information

* Browse Applications > Accounting > Accounts Payable > Year-End Processing > Create 1099 Information
=) ldentification New Copy W | Delate 10f 1 New Table | Query W |[] | X
Parameter ID * Description *

Selection Ranges

Option Start End
Taxable Entity A . ) )
Pay Vendor * [ ) )
Options
Calendar Year ™ 2039 Q

The Create 1099 Information screen calculates 1099 information used to print 1099-MISC income
amounts. When you use this screen, the process creates 1099 information for all vendors designated as
1099 vendors, regardless of how much 1099 income has been paid to them.
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To create 1099 information, Costpoint must access check data for vouchers that contain 1099 amounts.
Before you create and print 1099s for these vendors, you must record the checks against the vouchers
and post the checks.

Costpoint uses the following process to calculate 1099 income:

= Vendor Check History Table — Identifies all pay vendors in the range that had payments in the
current year. Eliminates non-1099 vendors. Identifies which checks were paid to these pay
vendors in current and prior years, then totals the amounts of these checks by voucher.

= Voucher Line Account History — Costpoint totals the 1099 amount of each voucher by 1099
Type.

= Cash Organizations — After the voucher line 1099 amounts are totaled, the process identifies
the cash organizations from which the 1099 vendors were paid and uses these cash
organizations to map the pay vendors back to the proper Taxable Entity.

= Calculate 1099 Amount — The following examples illustrate 1099 amount calculations.

If you have more than one Taxable Entity set up, you must complete the following steps:
1. Map organizations to specific Taxable Entities via the Manage Organization Elements screen.

2. Enter information about your Taxable Entity on the Configure Company Information screen.

Example A
Voucher: 1099 Amount $ 100.00 (a)
Non-Taxable Amount 80.00
Total 180.00
Total Prior Year Payments $ 70.00 (b)
Total Current Year Payments 110.00
Total 180.00
Voucher: 1099 Amount $100.00 (a)
Total Prior Year Payments 70.00 (b)
Current Year 1099 Amount 30.00

Reportable 1099 amount = Total Current Year Payments or (1099 Income (a) - Total Prior Year Payments
(b))

Total Current Year Payments = $110.00

(1099 Income (a) - Total Prior Year Payments (b)) = ($100) - $70 = $30

Since $30 is less than $110, Costpoint uses $30 as the 1099 income. After prior year payments, only $30
of 1099 income remained to be paid off in the current year. The other portion of current year payments
was made on non-1099 amounts.
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Example B
Voucher: 1099 Amount $ 100.00 (a)
Non-Taxable Amount 80.00
Total 180.00
Total Prior Year Payments $ 20.00 (b)
Total Current Year Payments 60.00 (c)
Total 80.00
Voucher: 1099 Amount $100.00 (a)
Total Prior Year Payments 20.00 (b)
Current Year 1099 Amount 60.00 (c)
Remainder for future year 1099 20.00

Reportable 1099 Amount = Total Current Year Payments (c) or (1099 Amount (a) - Total Prior Year
Payments (b))

Total Current Year Payments (c) = $60
(1099 Amount (a) - Total Prior Year Payments (b)) = ($100 - $20) = $80

Since $60 is less than $80, Costpoint uses $60 as the 1099 Amount. While the voucher included $80 of
1099 income after prior year payments, the vendor only received $60 of that in the current year. The
vendor can only be taxed on 1099 income actually received in a calendar year.

Print 1099 Edit Report

* Browse Applications > Accounfing = Accounts Payable > Year-End Processing > Print 1099 Edit Report
=) ldentification New | Copy W | Dalate 1071 Hew Table | Query W |[]| 7| X
Parameter ID* Description *
Selection Ranges Sort By
Option Start End 1st Sort*
Taxable Entity (Al v ) ) |Taxable Entity v
Pay Vendor |All A l l
Calendar Year One 2039°Q
Options
Optional Page Break
Al Taxable Entity [] At Vendor

[] Include Vendors where payments are below the reportable amount

Use the 1099 Edit Report to review your 1099 information for discrepancies before printing 1099s. To run
this report, you must have already created 1099 Information using the Create
1099 Information screen.

This report prints the pay vendor’s ID, the vendor 1099 name and tax ID, the 1099 type and amount, and
the taxable entity’s ID and tax ID. The address codes and addresses for vendors do not print on this
report.
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Select the Include Vendors where payments are below the reportable amount check box to include
vendors with payment amounts below the reportable amount. Leave the check box cleared to exclude
them.

= If you sort the report by Taxable Entity, the total amount of 1099 income prints as a subtotal for
each company. The total number of records for each Taxable Entity also prints on the report.

= If you sort the report by pay vendor, a grand total of all 1099 income prints on the report as well
as the number of 1099 records.

Note: For the Range Option in the Select Pay Vendor group box, you can use Lookup in the From
and To fields to select a Pay Vendor ID. Your choices are limited to those pay vendors flagged for
1099 creation on the 1099 section of the Manage Vendors screen.

Tips for Printing the 1099 Edit Report
To save your sort options and selection criteria for this report (with or without printing), complete
the following steps:

1. Enter an alphanumeric identifying parameter ID and a short description for this set of print
parameters.

2. After making your selections, click the Save icon in the toolbar or click File » Save.
3. Click Close.

Later, you can use Find or Query from this screen to access the print parameters you created and run the
same report without having to enter all the information again.

Sample 1099 Edit Report

Year End Company
Page 1 of 1
1099 Edit Report 0a04/18
Calendar Year. 2039 03:17 PM
Pay Vendor Vendor 1099 Name TaxID 1098 Type 1089 Amount
Taxable Entity: 1/ACME PRODUCTION
Tax ID: 313441341
1099NON 1099 NON EMPLOYEE 52-0223375 NONEMP 35,000.00
Total Amount for 1099NON: 35,000.00
Total 1099 Amount 35,000.00
Total Number of Vendors: 1 Total Taxable Amount: 35,000.00
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Edit 1099 Information

% [0 Browse Applications > Accounling > Accounis Payable > Year-End Processing > Edit 1099 Information
Identification 1 of 1 Existing Table | Query W [] ™ || X
Taxable Entity 1 ACME PRODUCTION
Calendar Year 2039 TaxID 313441341
Total 1099 Amount 35,000.00 Total Taxable Amount 35,000.00
Edit 1099 Information Detail New | Copy W | Delete | Form | Query W |~
- Pay Vendor
- Pay Vendor*  Cash Organization *| | 1099 Type * Tax ID Address Code Print Address Foreign Adc1098 Amount® Notes Long Name 1099 Name
1099NON 1 NONEMP  |52-0223375 BILLING ) D v | 35,000.00 1099 NON EMPLOYEE 1099 NON EMPLOYEE
4 ] " >

Check Detail

Use the Edit 1099 Information screen to view, edit, and add 1099 income information for pay vendors, by
taxable entity. To use this screen, run Query or Find to select a taxable entity and calendar year.

You can edit the 1099 amount and address code or delete lines of information for existing vendors if you
have already run the Create 1099 Information screen. However, if you run the Create 1099 Information
screen again, you will lose any edits that you have made.

The difference between the Total 1099 Amount and the Total Taxable Amount is any payment that is
less than the Reportable Amount. The 1099 does not print any amounts that are below the reportable
amount. For example, if a 1099-MISC for NONEMP totals to $500.00, it does not print because it is less
than the limit of $600.00; it is included in the Total 1099 Amount but is not included in the Total Taxable
Amount.

Click the Check Detail button to display the Check Detail subtask (see page 143). Use the Check Detall
subtask to view payment data for each pay vendor to help you reconcile discrepancies in 1099 income.

After you use the Create 1099 Information application to create 1099s, you can use the Edit 1099
Information screen to add a 1099 line and/or delete an existing line.
To add a 1099 line:
1. Gotothe word Line.
2. Click New Record or press CTRL+N.
3. Enter the required information on the line and save. After the line is saved, you cannot edit the
new line you just created, but you can delete it.
To delete an existing line:
1. Highlight an existing line.
2. Click the toolbar function LINE.
3. Click Delete Record.

If you make edits to this screen, you will lose them if you execute the Create 1099 Information application
again.
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Check Detail Subtask of Edit 1099 Information

Identification > Check Detail

Total Paid Amount

Vendor Check Detail

70,650.00

E__ Check Number
|

368 02/18/2039
369 09/04/2039

_Paid Amount al
5,000.00

15,000.00

Voucher Number | IE'

24145) 5
24124

To display the Check Detail subtask, highlight a row on the Edit 1099 Information screen and click the

Check Detail button.

Use this subtask to view data for each pay vendor. The information displayed on this subtask comes from
the Vendor Check History, Vendor Check History Voucher Detail, and Voucher Header History tables. All

fields on this screen are non-editable.

If you are using this subtask from a new line, you must enter the pay vendor and cash organization before

Costpoint can access any information.

The Check Detail subtask's Total Paid Amount field reflects checks that have been issued to this
vendor; however, it does not reflect any checks that have been voided. Voided checks are not included in

the 1099 amount on the main screen.

Print/Create 1099s and Magnetic Media

* @

Browse Applications =
=3 ldentification

Parameter ID* Description *
Generate

(@) Print 1098s () Create Magnetic Media

Selection Ranpges

Calendar Year* 2039 Q

Option
Pay Vendor Name*  (All M
Taxable Entity One

Options
Print Format

(®) 1099-MISC Standard () 1099-MISC Self-Mailer

Magnetic Media Information
Test Prior Year
Location )
File Name
Contact Name
Phone Number/Ext
Email Address

Transmitter Info

TIN Control Code

Name

Accounting > Accounts Payable =

Print Option |-None-

Start End

Copy B Options
[ Recipient ID Masking

Override File

Year-End Processing = Print/Create 1099s and Magnetic Media

Mew | Copy W | Delete 1 of 1 New Tale | Query W []| 7| X

Recipient ID Masking Character

Use this screen to print 1099s or create a file of 1099-MISC information. See the table on page 6 for a
summary of the boxes, descriptions, limit amounts, and Costpoint codes.
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Note: Costpoint supports the masking of the vendor Tax ID when printing. This should only be used
when printing the Copy B of the 1099.

You can create 1099 information for past or future years. Costpoint prints them using the current year’s
1099-MISC format.

The Print 1099s program prints 1099-MISC information on pre-printed, official IRS forms for laser printers.
Self-Mailers are available if you select Laser as the printer.

Costpoint supports printing standard 1099-MISC forms and 1099-MISC Self-Mailers.

After printing 1099s, Costpoint displays the number of 1099s printed and the total amounts for each type
of 1099-MISC income. If you miss the message, print 1099s to a file, with the same parameters. At the
end of the run, note the final count and amount, and then delete the file.

Note: To ensure that your 1099 information is correct, print 1099s on blank paper before printing
them on the forms and before you create the file. After you create the file, you will not be able to
correct any errors without recreating the entire file.

Create Magnetic Media

W [I Browse Applications > Accounfing = Accounts Payable > Year-End Processing = Print/Create 1099s and Magnetic Media
=3 ldentification New Copy W | Delste 10f 1 New Taple | Query W |[] | X
Parameter ID* Description *
Generate
() Print 10993 (®) Create Magnetic Media Print Option

Selection Ranges

Calendar Year * 2039 Q
Option Start End
Pay Vendor Name * All l |
Taxable Entity One 129320 )
Opfions.
Print Format
Copy B Options
(®) 1099-MISC Standard () 1099-MISC Seli-Mailer Recipient ID Masking Recipient ID Masking Character

Magnetic Media Information
[] Test [] Prior Year

Location I [ Overmide File
File Name

Contact Name

Phone Number/Ext

Email Address

Tranzmitter Info

TIN Control Code

Name

You can only create a file for electronic filing for one taxable entity at a time. You must use a separate file
name for each taxable entity or you will have to copy the file to a different directory before creating the
next electronic file.
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Screen Contents

Magnetic Media Information Group Box

This group box contains data fields that hold information that you can include in the file to transmit
electronically. Select the Create Magnetic Media option to enable this group box.

Prior Year — Select this check box if the year you specified in Calendar Year is a prior calendar
year filing. If you select this setting, a P is inserted in Field Position 6 of the T record. By default,
this check box is cleared and is enabled, if creating the file to send electronically.

Test — Select this check box if you want to send a test file to the IRS. To show that the file is a
test file, Costpoint marks it with a test indicator T in the Field Position 28 of the T record. A test
file is sent to the IRS if this is your company’s first Tax Year (TY) to file 1099 information.

File Name — Enter the alphanumeric name in this required field; for example: IRSTAX. .

Contact Name — Enter the name of the person to contact if the IRS/MCC encounters problems
with the file or transmission. This alphanumeric field is required. The name that you enter here is
inserted in Position 304-343 of the T record.

Phone Number/Ext — Enter the telephone number of the person to contact about electronic
filings, with area code and extension, in this numeric field. This field is required. You do not need
to enter hyphens. For example, you could enter 304.263.8700 extension 5234 as
30426387005234. The phone number is inserted into Position 344-358 of the T record.

Email Address — Enter the email address of the person the IRS should contact if there are any
questions.

Transmitter Info Group Box

This group box contains IRS Transmitter information that will be included in the file.

TIN — Enter the transmitter’s nine-digit Tax Identification Number; this may be an EIN or SSN. If
you leave this field blank, the TIN for the Company ID selected on this screen will be used. This is
not a required field. This number is inserted into Position 7-15 of the T record.

Control Code — Enter the five-character alphanumeric Transmitter Control Code (TCC)
assigned by the IRS/MCC. You must obtain a TCC to file data within this program. This code is
issued after you file the application for Filing Information Returns Magnetically/Electronically (IRS
FORM 4419). This is a required field.

Name — If the Transmitter name is different from the Company name, enter the Transmitter
Name here. If the Transmitter name is the same as the Company name, then you can leave this
field blank. The Transmitter Name is inserted as the Company Name in Position 30-69 in the T
record. This is not a required field.

Print Format Group Box

1099-MISC Standard — This setting is enabled for both laser and impact printers. All copies of
the 1099 have the same format this calendar year.

1099-MISC Self- Mailers — This selection is available for laser printers. See Chapter 2: Ordering
Forms for instructions on how to order forms, including Self-Mailers.

Selection Ranges

Calendar Year — Use the drop-down list to select the calendar year for which you are reporting
to the IRS.
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= Pay Vendor Name — Enter the range of pay vendors by specifying the range of vendor IDs.

= Taxable Entity — Specify the taxable entity for which the 1099s will be printed/created. Please
contact Deltek Customer Care if you need to print 1099s for a prior calendar year.

Sample 2018 IRS 1099 Form

See Appendix A for a sample of the 2018 IRS 1099 form and links to the IRS Web site.
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Closing the Leave Year Checklist

Use the following checklist as you close the leave year.

1. Make sure that the Leave Period Schedule for the new year has been added for
all leave cycles.

2. Make sure that Timesheets with dates equal to or less than the last leave period
date for the year have been entered and posted to labor.

3. Make sure that Leave Accruals for the last leave period of the year have been
processed and posted to the General Ledger.

4. Print the current leave year’s Accrual Leave Report (keep the header page)
and review for accuracy.

5. Use the Reconcile Leave Balances Utility to have Costpoint create a journal
entry that trues up leave liability.

6. Verify that Leave Year Ceilings established on the Manage Leave Codes
screen are accurate.

7. Verify that the Calendar Year-End (CYE) Regulatory Update is installed before
closing the leave year.

8. Close the leave year.

9. Print the new leave year’'s Accrual Leave Report (keep the header page) and
review for accuracy.

Accessing the Leave Application

To access Leave, click People » Leave » Leave Processing.
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Before You Close the Leave Year

% [0 Browse Applications > People > Leave = Leave Controls = Manage Leave Codes
Identification New | Copy W | Delete 1 of 1 Existing Table | Query W |[]| | X
Leave Code*  WAC40 Description®  Vacation
Options
Leave Type ™ VAC . [[] Excess Leave Type
Payout Leave Code l Basis for Leave Deferral Leave Based on Hours Worked
[ Include Negative Balances in Leave Year Carryover @) Hire Date Leave Modifier l

[ Report Leave to Employee in Days (O Leave Hire Date

Base Hours Worked on Eligible Labor Locations
Hours in Leave Day 0.00 Days to Defer Leave Usage 0 O
Eligible Labor Locations ~ Leave Table Details
Identification > Leave Table Details New | Copy W | Delete | Fom |Query ¥ ||[F|™ |[J| X
—  Months Compute Unit of Annual (C) ‘One-Time (D) Period Balance | Year Balance Period Accrual Year Accrual
of Service * Method * Hours | Block GrantDate Block Grant Date Accrual Rate™ | Ceiling* Ceiling * Ceiling * Ceiling *

0 P-Leave Period o 5.000000 120.00 80,00 999,999,999,099,995 00  999,999,999,999,999 00

60 P-Leave Period 0 7.000000° 168.00 160.00 ©99,990,000,000,999 00 999,999 999,009,998 00

120| P-Leave Period ‘ 0‘ | 10.000000 | 240.00 20000 999,999,999,009,999.00| 999,999,999,999,999.00

Close

Before you close the leave year:
1. Verify that Leave Year Ceilings on the Manage Leave Codes screen are accurate.

2. Decide if Costpoint should bring negative balances in the leave year forward into the new leave
year. If so, select the Include Negative Balances in Leave Year Carryover check box on the
Manage Leave Codes screen.

3. Verify that the Leave Period Schedule for the new leave year has been added for all leave cycles
on the Manage Leave Periods screen.

4. Verify that timesheets with dates equal to or less than the last leave period date for the current
leave year have been entered and posted to labor.

5. Verify that leave accruals for the last leave period of the year have been processed and posted to
the General Ledger.

6. Print the Accrual Leave Report for the Current Year (Keep Header Page) and review for
accuracy.
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Reconcile Leave Balances

% [0 Browse Applications > People > Leave = Leave Utilities > Reconcile Leave Balances

=» ldentification Mew | Copy W | Delete 10f 1 New Tabke | Query W |[] | X
Parameter ID* Description *
Selection Ranges Journal Entry Accounting Period
Option Start Fiscal Year* 2039 )
Leave Cycle One CYE l Leave Period End Date 12131/2039 Period * 13
All Employees Subperiod * 1
Processing Options
Multicurrency
[ Include Terminated Employees. Currency Clearing Account l

Warning: If no Clearing Account is provided, Transactional Currency Amounts

[ Include Liability from Past Leave Years.
in the General Ledger will be out of balance for individual currencies.

Employees
Identification > Employees = —|OxX
’7 Employee * Name |

Close

In Configure Leave Settings if Reconcile Leave Balances is set to Account:

Use the Reconcile Leave Balances to have the system true-up the general ledger leave accrual balances
to the leave history balances. Costpoint compares the accrued liability to the General Ledger’s balance
and creates a journal entry for the differences it finds. Costpoint does this by multiplying the current year’s
ending leave hours by the employee’s current hourly rate found on the Manage Employee Salary
Information screen.

In Configure Leave Settings if Reconcile Leave Balances is set to Employee:

Use the Reconcile Leave Balances to have the system true-up the Leave History balance to the current
accrued liability. Costpoint does this by multiplying the current year’s ending leave hours by the
employee’s current hourly rate found on the Manage Employee Salary Information screen.

It then will create a journal entry for the difference found between the calculation and balance in Leave
History.

For either reconciliation method, you can run this process multiple times throughout the leave year. Since
Costpoint reconciles based on the system date (date the process is run) and accounting period
associated with it, you should run this process before the end of the year.

Warning: Leave Reconciliation is based on the system date and the accounting period that date falls
within. In order to reconcile leave for the current leave year, it must be run when the date still falls in
the current year. If it is not run until the system date is within the new leave year, Costpoint will
reconcile leave for the new year.
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Close Leave Year

w EI Browse Applications > People > Leave > Year-End Processing > Close Leave Year
=) Identification Mew | Copy W | Delete 10f1 New Table | Query W |[] T | X
Parameter ID * Description *
Selection Ranges Options Adjustment Records
Leave Cycle®  |CYE Q| Year End [ Include Inactive Employees Fiscal Year * 2039 )
Leave Period Data [] Base New Balances and Payout on New Leave Year Salary Period * 13
Start Date End Date Leave Year [] Reconciliation done prior to closing the leave year Subperiod * 1
Current 1216/2039 1213172039 2039
New 01/01/2040 011572040 2040 Report Sort * Employee Name v

To close the leave year:
1. Check the dates in the Leave Period Data group box.

= Make sure that the Current Start Date and Current End Date are for the last period of your
Current Leave Year.

= Make sure that the Next Start Date and Next End Date are for the first period in your New
Leave Year.

2. Select the Include Inactive Employees check box if you want employees marked as inactive to
appear on the report.

3. Select the Base beginning balances on new leave year hourly rate check box if you want the
beginning balances of your new leave year to be based on the hourly rate that corresponds with
your new leave year. If not selected, the system will use the hourly rate associated with your old
leave year for the beginning balance in your new leave year.

4. Select Reconciliation done prior to closing the leave year if reconciliation has been completed
before closing the leave year.

a. If reconciliation has been done, Costpoint will use actual amount balances from the
employee leave table.

b. If reconciliation has not been done, Costpoint uses employee’s hourly rate to create the
G/L Adjustment.

5. Select the Fiscal Year, Period, and Subperiod to which leave balance adjustments (due to
excess over ceiling) will be posted when you run the Close Leave Year process.

When you execute the Close Leave Year screen, Costpoint:
= Recognizes the Leave Year ceilings.

= Generates the new leave balance for review prior to closing. The Close Leave Year Report shows
the leave to be lost.

= Updates the beginning balances on the Manage Leave Beginning Balances screen with a new
line for each Leave Type assigned to the employee

= Closes the last Leave Cycle and opens the New Leave Cycle on the Leave Periods screen.

= |f Reconciliation method is by Account: Creates and posts an entry to the General Ledger if
transfer balance in excess of year ceiling is set up in Manage Leave Types.

= |f Reconciliation method is by Employee: Creates and posts an entry to the General Ledger if
an employee’s yearly balance exceeds the Year Ceiling.
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Warning: If timesheets containing a timesheet date fall within a leave period associated with a future
leave year, and those timesheets contain used leave, a record with the future leave year will be
created in the leave history tables. This will prevent the current leave year to be closed using the
Close Leave Year screen. Beginning balances would have to be updated manually for the new leave
year.

After You Close the Leave Year

* Browse Applications > People » Leave > Leave Processing > Print Leave Accrual Report

=3 ldentification New | Copy W | Delate 1 0f 1 Hew Table | Query W [ X
Parameter ID* Description *
Selection Ranges Sort By
Option Start End 15t Sort*
Effective Date One 01/0172040 4 [Home Organization ~ +
2nd Sort*

Leave Year One 2040
|[Employee Name v

Leave Cycle |One v CYE |
Leave Type (A v )
Organization |Al v l l
Options
Include Page Break
[] Pan-Time Employees [] Temporary Employees [] Leave Lost [] Defermred Leave [] Page Break on Employee

After you close the leave year:

1. Print the Accrual Leave Report for the New Leave Year (Keep Header Page) and review for
accuracy.

2. Compare the Prior Leave Year Accrual Report to the New Leave Year Accrual Report. The
difference should be Leave Lost due to the Leave Year Ceilings.

3. Ifthe New Leave Year Beginning Balances do not equal the expected balances, make
corrections on the Manage Leave Beginning Balances screen.

Timing Considerations: Example

For this example, assume the following:
= Payroll and Leave periods are bi-weekly.
= The last period of the year is December 9 through December 22.
=  The first period of the new year is December 23 through January 5.
= You enter timesheets weekly for the bi-weekly payroll cycle.

= The last payroll of the year will include timesheets dated December 9 through December 15 and
December 16 through December 22.

=  The first payroll of the year will include timesheets dated December 23 through December 29 and
December 30 through January 5.

= The fiscal year is January 1 through December 31.
How will cost be recognized for fiscal year accounting?

= Payroll — For the pay period December 23 through January 5, payroll would normally be posted
in the new fiscal year. An estimated accrual may be done based on the accrued salary amount for
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14 days. The total accrual will be divided by 14 to get an estimated daily figure and multiplied by 9
to receive the estimated December 23 through 31 accrual amount. A reversing journal entry will
be done in the General Ledger Module to record the estimated December 23 through 31 accrual
amount in the current fiscal year and the reversing journal entry in the next fiscal year will reduce
the payroll posting.

= Labor Costs — If using Time Collection, your Timesheet Schedule in the Time Collection
database must be adjusted so that December 23 through 31 is an individual cycle. Likewise, the
period of January 1 through January 5 must be recognized as an individual cycle. Nothing needs
to be done in Costpoint. When uploading timesheets from Time Collection, or when entering
timesheets directly into Costpoint, you need to enter the time for December 23 through 31
separately, using a December 31 date. If you have salaried employees and auto-adjust
timesheets, you need to change the percentage for this input as well as prorating the total of
100% across both timesheets.

= Leave Accruals — Leave accruals must be computed for the full leave period December 23
through January 5 and should be posted to the new fiscal year in the General Ledger of 2019,
which also matches the leave year associated with that leave period. Create a journal entry to
move the portion that belongs to the 2018 fiscal year (December 23 through 31) and post it in
2018. Create another journal entry to remove the 2018 portion from the 2019 year and post it to
the 2019 fiscal year.

When dealing with used leave and leave years, keep the following points in mind:
1. The Timesheet Date determines the Leave Period to which the used leave will post.

2. The Leave Year associated with the Leave Period determines the leave year to which the
used leave will be posted.
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Chapter 5: Payroll Processing

Closing the Payroll Year Checklist

Use the following checklist as you complete your year-end steps for payroll processing.

1. Make sure that the Pay Period Schedule for the new year has been added to all
Pay Cycles.
2. Print the Social Security and Medicare Reconciliation Report from Payroll » Tax

Reporting and verify that the correct amount of Social Security and Medicare
has been withheld and accrued.

3. Make any needed corrections on the last payroll of the year.

4, Process (enter) all paychecks to be dated December 31 or earlier and post to
the General Ledger.

5. Make any adjustments on the current paycheck for taxes owed from the results
of the Print Social Security and Medicare Reconciliation Report or other
transactions you know must be accounted for at this time.

6. Perform the steps for Closing the Payroll Year.

7. Verify that any Pay Types that should be reported in Box 11 (Non-qualified
Plans Distribution) have been linked in the Payroll Controls » Manage Pay Type
Taxability screen.

8. Verify that any Deductions that should be reported in Box 12 have been linked
with the correct Deduction Type in Payroll » Deductions » Manage Deductions
screen.

9. Verify that any Deductions which you want to report in Box 14 have been linked
in Payroll » Deductions » Manage Deductions/Federal tab.

10. Verify that appropriate Deductions are designated as Employer-Sponsored
Health Coverage by checking the box on the Manage Deductions screen.

11. Verify that the Retirement Plan Covered check box is selected on the

Employee Payroll Information » Manage Employee Taxes screen for each
employee who participates in a qualified pension plan.

Accessing Tax Reporting

To access Tax Reporting, click People » Payroll » Tax Reporting.
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Before You Close the Payroll Year

b 4 EI Browse Applications = People = Payroll = Tax Reporting = Print Soc Sec and Medicare Reconciliation Report

=3 Identification Mew | Copy W | Delete 10f 1 New Taple | Query ¥ [] 7| X
Parameter ID* Descripion *

Options
Report Type Medicare
Social Security

Select Report Options
Range Type Start End
Taxable Entity One ) 1st Sort* [Employee Name v
Check Dates Range ) )

Before you close the payroll year:

1. Print the Social Security and Medicare Reconciliation Report and verify that the correct amount of
Social Security and Medicare has been withheld and accrued.

2. Make any adjustment on the current paycheck for taxes owed from the results of the Print Social
Security and Medicare Reconciliation Report or other transactions you know that must be
accounted for at this time.

3. Enter (process) all paychecks to be dated December 31 or earlier and post to the General
Ledger.

4. Add the Pay Period Schedule for the new year to all Pay Cycles.

Check the Ceiling Method option on the Manage Deductions screen and make changes if
needed:

* E Browse Applications > People > Payroll > Deductions > Manage Deductions

Deduction New | Copy W |Delete | | | 4  5of8Exsting P | | Tabe Quey W [] | X
Deduction Cade * 401KLN Short Desc™ A01KLN Description * 401K Loan
TN Fese
Deduction Type * LOANDC ] Employee Deferred Comp. Loan | [] Employer-Sponsored Health Coverage
[ Deduction
Computation Method ~ FIXAMT | ICemng Method*  (One-Time v l Pay Type ]
Rate % 0.0000% Ceiling Amount 100.00 Workers Comp l
Amount 50.00 Eligible for Arrears Union Rate 0.000000
Modify Code l Arrears Deduction l Start Date ]
Priority 1 Through Date |

[ Contribution

Computation Method NO DED

Base on Additional Deductions

Rate % 0.0000% Ceiling Amount 0.00 Start Date
Amount 0.00 HSA Deduction ) Through Date
Modity Code )

Payroll Tax Interface
Tax Type -None- v State )

Tax Service Code

State Local Contribution Matching  Adgitional Deductions for Contribution Calculation  AcciVend/Rei No

6. Use the One Time ceiling method for items such as 401(k) loans that span more than one payroll
year. The Close Payroll Year program calculates the unpaid balance of the deduction and
replaces the ceiling amount on the Manage Employee Deductions screen with the unpaid
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balance. If necessary, add the One Time ceiling method to the Manage Deduction screen prior to
closing the payroll year.

Note: If necessary, you can re-open the last pay cycle in the Payroll Year to enter additional payroll
records as long as they do not affect One Time ceiling method deductions.

Close Payroll Year

* Browse Applications > People > Payroll = Year-End Processing > Close Payroll Year

=3 ldentification New | Copy W | Delete 101 New Tagle | Query W |[]| ™| X
Parameter ID* | Description *

Selection Ranges Sort By
Option Start 1st Sort*
Pay Cycle One ) [Employee ID v
Pay Cycle Data

Start Date End Date Payroll Year
Current

Next

You must use this screen to close the payroll year.

Verify that the Pay Cycle Data is correct for both the Current and Next Lines. Make sure that the Current
Payroll Year reads 2018 and the Next Payroll Year reads 2019.

= If you run this screen and receive a message saying No rows found that meet selection
criteria, it means that you have no deductions with a ceiling method of One Time. You must still
close the payroll year.

= If you do have deduction methods of One Time and employees who are actively using them, you
will receive a report listing the employee name, deduction code, current limit, total deduction, and
new limit. After you review the report for accuracy, you should close your Payroll Year.
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After You Close the Payroll Year

After you close the payroll year:

1.

Insert a new line under Payroll » Federal Taxes » Manage Federal Taxes with the new Payroll
Year information. This will not be updated in the CYE Regulatory Update.

* Browse Applications

Identification
Payroll Year* 2019

Details

Social Security Adjusting Amounts

Wage Limit * 132900.00 Exemption Amount *
Employer Rate * F Nonresident Alien

plor £.20% Additional Amount *
Employee Rate * 620%

Supplemental Wages

Medicare Supplemental Tax Rate
(51,000,000 and Under)*

Wage Limit * 9,999,999.00
Supplemental Tax Eale
Employer Rate * 1.45% (Over $1,000,000)
Employee Rate ™ 1.45% 2010K)
Additional Tax Threshold* 200,000.00 Wage Limit *
Additional Tax Rate * 01.90% Deferral Limit *
FUTA Affordable Care Act
Wage Limit * 7,000.00 Federal Poverty Level
Employer Rate * 0.06% Safe Harbor Affordability Rate ®
Credit Rate * 540%

= People > Payroll > Federal Taxes > Manage Federal Taxes

New Copy ¥ Delete 1 of 26 Existing P | B | Table |Query W []— X

4,150.00

7,850.00

22.00%

37.00%

280,000.00
19,000.00

12,140.00
0.0986)

FUTA Credit Reduction States

You should use the tax information below to process payroll for 2019. This is the most current

information available at this time (November 2018).

Social Security Limit

Medicare Limit (no ceiling)
Medicare Additional Tax Threshold
Medicare Additional Tax Rate
Federal Exemption Amount

401(k) Deferral Limit

401(k)Catch Up for Age 50 or over
401(k) Wage Limit

FUTA Limit

FUTA Percent

Nonresident Alien Additional Amount

* All wages subject to Medicare Tax
A 2019 amounts not known at time of printing

$132,900
$9,999,999*
200,000.00
0.90%
$4,150 »
$19,000
$6,000
$280,000
$7,000
.6%

$7850.00"
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2. In Payroll » Deductions » Manage Deductions, update any deductions or contributions that
have had an increase/decrease for the next payroll year. You can use the Employee »
Employee Payroll Information » Update Employee Deductions/Contributions screen to
update the changes before the first payroll of the new year for each employee.

2019 state tax information that Deltek receives on or before January 15, 2019 will be shipped with the
Costpoint Tax Table Update in the first quarter of 2019.

W-2 Processing

Before You Create W-2s

Before you create W-2s, complete the following steps:

1. Perform the steps for closing the Payroll year.

2. Verify that any Pay Types that should be reported in Box 11 (Non-qualified Plans Distribution) have
been linked on the Payroll Controls » Manage Pay Type Taxability screen.

3. Verify that any Deductions that should be reported in Box 12 have been linked with the correct
Deduction Type on the Payroll » Deductions » Manage Deductions screen.

4. Verify that any Deductions that should be reported in Box 14 have been linked on the Payroll »
Deductions » Manage Deductions » Federal tab (for informational purposes only; this is not

required).

5. Verify that appropriate Deductions are designated as Employer-Sponsored Health Coverage by
checking the box on the Manage Deductions screen.

6. Verify that the Retirement Plan Covered check box is selected on the Employee Payroll Setup »
Employee Taxes screen for each employee who participates in a qualified pension plan.

Manage Local Taxes

Local Taxes >

* m Browse Applications = People >

Payroll =

Manage Local Taxes

=» Manage Local Taxes New | Gopy W | Delete 1of 1 New Table | Query W [ || X

Locality *

Local Tax Setup
. Disability Insurance Type Family Leave Insurance Type
State ™ l
() State Plan () State Plan
Tax Paid By @) Employee (O Private Plan () Private Plan
(O Employer (®) Not Applicable (®) Not Applicable
Tax Type
o New York W-2 Reporting Ohio Tax Collection Agency
City / County /
Sehool IPSD Code O New Yaork City ORITA
Yonker: (JC.CA
Character Code onkers CA
(@) Not Applicable (@) Not Applicable
i Payroll Tax Interface

Withholding Account ] ]

Accrual Account l ' +/ Include in Export Payroll Taxes

Expense Account ) ] Tax Service Code

Tax D/ Reference Numbers / Vendor Information
Local Tax Details New Form -
7 Effective Tax Supplemental State WiH Annual Exempt Amt Exempt Amt Exempt Amt Credit
| Date * Based On* Tax Rate ™ State Credit Limit*  One Time Annually Ceiling Limit * Married * Single * Other * Amount *
4 >

= The Disability Insurance Type group box is available if you select State Disability Insurance
from the drop-down list for the Tax Type field.
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= The Family Leave Insurance Type group box is available if you select Family Leave Insurance
from the drop-down list for the Tax Type field.

State-specific notes are summarized in the following table.

State Field and Description

Indiana County/School/Political Subdivision Code

If you are creating State Magnetic Media (an electronic file) for Indiana, you must
enter County Codes in Local Taxes for Indiana County Taxes. Report County
Codes in the electronic file only. Do not report County Codes on the printed W-2.

Costpoint does not provide the Indiana County Codes. For a list of the codes, see:
http://www.IN.gov/dor/taxforms/pdfs/w-2book.pdf.

Pennsylvania County/School/Political Subdivision Code

Be sure to enter the correct Pennsylvania political subdivision code.

Ohio County/School/Political Subdivision Code

If you are creating W-2s for the state of Ohio, you must enter School District
Numbers in Local Taxes for Ohio School District Taxes. The four-digit Ohio School
District Codes are required for the printed W-2 and the electronic file.

New York New York W-2 Reporting group box
This group box is available when you set the State field to NY.

If the employee’s state is NY the amount in State wages, tips, etc. should equal
the Federal wages in box 1, Wages, tips and other compensation. Part-year New
York State residents should be treated the same as full-time residents and the
employee will allocate the part of his or her federal wages that are attributable to
services performed in New York State when filing the New York State part-year
resident income tax return.

New York City

If the employee is a full-year resident of New York City, the amount in Local
wages, tips, etc. should be the same as the federal wages reported in Box 1. If the
employee is a part-year resident of New York City, then the amount reported in
Local wages, tips, etc. should be only the amount of federal wages for the period
the employee was a New York City resident.

Yonkers

If the employee is a full-year resident of Yonkers, the amount in Local wages, tips,
etc. should be the same as the federal wages reported in Box 1. If the employee
was a part-year resident of Yonkers, he or she should be treated the same as full-
time residents and the employee will allocate the part of their federal wages that are
attributable to services performed in New York State when they file their New York
State part-year resident income tax return.

New Jersey Costpoint has three tax types that are specific to New Jersey:
= Supplemental Workforce Fund

= Unemployment/Health Care
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State Field and Description

=  Workforce Development Partnership Fund

Verify that the correct Tax Type is selected for New Jersey local taxes.

Manage Deductions Screen

W [i Browse Applications > People > Payroll > Deductions > Manage Deductions
=3 Deduction New | Copy W  Deleie 10f 1 New Table Quey W [ | X
Deduction Code * Short Desc * Description *
IEEEDN_Federal
[Dedumlon Type * |l ) [|—| Employer-Sponsored Health Coverage ]

[ Deduction

Computation Method NO DED l Ceiling Method * No Ceiling Pay Type l

Rate % 0.0000% Ceiling Amount 0.00 Worker's Comp '

Amount 0.00 Eligible for Amears Union Rate 0.000000
Modify Code | Amears Deduction | Start Date

Priority ] Through Date

[] Contribution

Computation Method NO DED

Base on Additional Deductions

Rate % 0.0000% Ceiling Amount 0.00 Start Date
Amount 0.00 HSA Deduction l Through Date
Meodify Code )

Payroll Tax Interface

Tax Type -Mone- v State '

Tax Semvice Code

State  Local Contribution Matchin Additional Deductions for Contribution Calculation  Acct/Vend/Ref No

Verify that the correct Deduction Type is associated with each deduction code before creating W-2s. The
drop-down list for the Deduction Types option includes the following settings:

= Employee HSA Contr (Caf Plan) — Employee HSA Contributions through a Cafeteria Plan. This
is a pre-tax deduction and will be reported in Box 12 with a Code W.

= Employee HSA Contr (Non Caf Plan) — Employee HSA Contribution not through a Cafeteria
Plan. This is the post-tax deduction; it will not be included in Box 12.

= UI/HIth Care/Workforce Dev — This option is for employers who track the NJ Ul/HIth
Care/Workforce Dev through deductions and report them in Box 14. This Deduction Type must be
used if you will be reporting Ul/Health Care/Workforce Development information through Box 14
and have Costpoint add the NJ SUTA (UI) dollar amount (from the Manage Employee Earnings
History records) to Box 14.

If the deduction code will be tracked under the employer-sponsored health plan, then be sure to select
this box before creating your W-2s.

Recompute Taxable Wages

Warning: The Recompute Taxable Wages utility recomputes taxable wages in the Employee
Earnings Table. This may cause a discrepancy in previously reported wages to government agencies.
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W [i] Browse Applications > People > Payroll > Payroll Utilities > Recompute Taxable Wages
=) Identification New | Copy W | Delete 1 of 1 New Table |Quey W |[]| ™| X

Parameter ID * Description *

Select Sort By

Range Type Start End

Taxable Entity One ) 1st Sort* TaxType v
Payroll Year One 2ndSo*  (EmployeelD v
Employees * v l l
Check Dales * .

Options
Apply Employee's
Recompute current taxability

F@UBTAL.....oocoeove oo
Social Security
MedICare. ........ococovrvvocerrrerrerrees
FUTA Taxable and Accrual

State.. e
SUTA Taxable and Accrual............

[] Update the Tax Service Group ID

oooooo

Possible reasons for using this screen include the following:
= A Deduction’s taxability was set incorrectly. Therefore, taxable wages are wrong.
= A Pay Type's taxability was set incorrectly. Therefore, taxable wages are wrong.
= An Employee was set up with the wrong tax status.

Run this utility before creating W-2s.

The results of using this utility are as follows:

= Taxable wages will be recomputed in the Employee Earning table with the current tax status on
the Manage Employee Taxes screen. If an employee’s status has changed during the year, you
may use the date range and employee range logic to specify the appropriate parameters. In this
case, run the utility for one employee/date range at a time.

= If a check range is selected that contains records for prior quarters, a correction may need to be
made with the government agency.
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Create W-2 Table

W [ Growse Applications > People > Payroll » Year-End Processing > Creale W-2 Table
=% ldentification New | Copy W  Delete 10ft New Table Quey W (]| X
Parameter ID* Description *
Selection Ranpes
Option Start End
Taxable Entity One l
Payroll Year One
Employee All v ' I [[] Non-Contiguous
Opfions Sort By
Box 14 Descriptions New Jersey Reporting
Line 1 NJ-SDI PP#
W 1st Son
Line 2 UIHCMWD * Box 14 Deductions
=3 Employes ID
|-Select-
Line 3 Box 14 Deductions

Recreale W2s y - .
[] Recreate W2s Box 14 Deductions with system adding Ul

Local Taxes

. . Empl e Mon-C R B
Local Taxes with system adding Ul e o

Guidelines for Creating W-2 Tables
= Create W-2s by employee.

= Use the select range options in List Mode for non-contiguous selections.

= W-2s are created by Taxable Entity. The Taxable Entity is determined by the Taxable Entity field
in Employee Earnings.

= All taxable wage information is taken from the taxable wage data fields in Employee Earnings.

Example

Use this screen to identify the optional deductions that you want to report in Box 14. For example, you
can use this screen for health insurance. Suppose you have one provider with three options:

=  Employee A = single
=  Employee B = family
= Employee C = single plus one dependent

On your deduction screen you have three separate deduction codes set up. You can link each deduction
to Box 14 on the Deduction screen. Here you would enter a description, such as HLTH. No matter which
health deduction the employee has, it will be reported on Box 14. You have three lines for this purpose.

New Jersey Reporting

Specify the NJ-SDI PP Number before creating your W-2s. The NJ-SDI PP Number prints on the W-2
only if the Local Taxes Disability Insurance Type field is set to Private Plan. (NJ does not want to see
the plan number if it is a State Plan). The NJ-SDI PP Number prints in Box 15 (State), under the
Employer's state ID number.

The settings in the drop-down list for the UI/HC/WD reporting option are specific to New Jersey (NJ):

= Box 14 Deductions — If this option is selected, Costpoint will not add the NJ SUTA dollar
amount to the total amount. Select this option if you want to use the current functionality for Box
14; only amounts associated with a Deduction Code that has a Box 14 line designated on the
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Federal subtask of the Deduction will be created. The NJ SUTA (Ul) amount will not be added to
the total amount, even if the Deduction Type is set to Ul/HIth Care/ Workforce Dev.

= Box 14 Deductions with system adding Ul — Select this option if you want Costpoint to add
the NJ SUTA (UIl) amount to the Box 14 Deduction amount. Costpoint adds the NJ SUTA dollar
amount to the Deduction Code that has the Deduction Type set to Ul/HIth Care/Workforce Dev
and that has a Box 14 line designated in the Federal subtask. Costpoint retrieves the NJ SUTA
information directly from the Manage Employee Earnings History records.

= Local Taxes — Select this option if you track Health Care, Workforce Dev Fund, and
Supplemental Workforce Fund through Local Taxes. All three types will be summed together and
reported in the boxes where local taxes information should be on the W-2.

= Local Taxes with system adding Ul — Select this option if you want Costpoint to add the NJ
SUTA (UI) dollar amount to the sum of the three Tax Types:

= Supplemental Workforce Fund
= Unemployment/Health Care
= Workforce Development Partnership Fund

Costpoint retrieves the NJ SUTA information directly from the Manage Employee Earnings History
records. W-2s may be created as many times as necessary; however, any prior edits will be lost at
the time of creation.

Possible Error Message

No Records Found: There is no information in the Manage Employee Earnings History screen for the
pay cycle and/or payroll year you have entered on this screen.

Manage W-2s
* Browse Applications > People > Payroll > Year-End Processing > Manage W-2s
= ldentification New | Copy W | Delete 10f1 Hew Table | Query W |[]| ™| X
Payroll Year * | Employee* ' Taxable Entity * '
Details
[ Void

a 1 2

Wages, Tips, other Compensation Federal Income Tax Withheld
b 3 4

Social Security Wages Social Security Tax Withheld
[= 5 6

Medicare Wages & Tips Medicare Tax Withheld

7 8
Social Security Tips Allocated Tips
e 9 10
0.00 Dependent Care Benefits

EL
Nonqualified Plans
f 13 14
[ Statutory Employee

[ Retirement Plan
[ Third-party Sick Pay

Box12 State Local

After you create W-2s, this table contains the information from Employee Earnings that will be on the W-2.
You can view and edit the data here. If an employee has more than one withholding state, he or she will
receive multiple W-2s. All federal information will be reported on the first W-2, with additional W-2s for
each state or locality.
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The box numbers on this screen correspond to the box numbers on the W-2 forms.

You can edit W-2s. However, you should make any edits to taxable wages, withholdings, or Box 12 on
the Manage Employee Earnings History screen for easier reconciliation of quarterly reports and for audit
tracking requirements. If you choose to re-create W-2s, any edits made here will be lost.

Information Sources

The sources of the information on the screen are as follows:

= Company information (boxes b—c) is taken from General Ledger» General Ledger Controls»
Configure Company Information.

=  Employee information (box e) is taken from Basic Employee Information» Manage Employee
Information.

= Boxes 1 through 11 come directly from the Employee Earnings table.

= Box 12 is a combination from Employee Earnings, as well as Deduction Type on the Manage
Deductions screen.

= State and Local information come from the Employee Earnings table.

= Tax Reporting information also comes from the Employee Earnings table. Thus, the total of the
W-2s should reconcile with the combination of the four quarters of tax filings by the company.

Manage W-2s: Box 12

Identification > Box 12

- Code * Amount *

gl Q|

Box 12 contains dollar amounts to be reported by IRS Codes. The proper reporting of these codes is
determined by the deduction type you selected in Payroll » Deductions » Manage Deductions.

If you reported non-taxable moving expenses as a pay type for an employee, you must complete
the following steps for Costpoint to report this as Code P in Box 12:

1. Set up a deduction in Payroll » Deductions » Manage Deductions and link it to the deduction
type of Non-Taxable Moving Expenses.

2. Add a Z record to Payroll History» Manage Employee Earnings History screen with a negative to
the pay type and a positive to the deduction.

If the employer made a contribution to a Medical Savings Account that needs to be reported as Code R in
Box 12, link this Deduction/Contribution Code to the deduction type of Employer Medical Savings
Account in Payroll » Deductions » Manage Deductions.
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Manage W-2s: State and Local

Box12  State Local

Identification > State New Form —|Olx
7 Employer's State Wages, State Income
(Box 15) * State ID (Box 15) Tips, Etc. (Box 16) Tax (Box 17) Notes
Close |
Identification > Local New Farm —Olx
v Locality Local Wages, Local Income
Locality * Name (Box 20) Tips, Etc. (Box 18) Tax (Box 19) Notes
Close |

Taxable wages and withholdings for states and tax localities display on these screens.

State Disability Insurance for the employee’s portion displays in Boxes 18, 19, and 20 and should have
been processed as a local tax.

New This Year

The following USERRA codes have been added to the Edit W-2 Information/Box 12 Lookup field:

D 17 — USERRA 2017 make up elective deferrals to a section 401(k) cash or deferred
arrangement.

E 17 — USERRA 2017 make up elective deferrals to a section 403(b) salary reduction
agreement.

F 17 — USERRA 2017 make up elective deferrals to a section 408(k)(6) salary reduction
agreement.

G 17 — USERRA 2017 make up elective deferrals and employer contributions (including
nonelective deferrals) to a section 457(b) deferred comp plan.

H 17 — USERRA 2017 make up elective deferrals under a section 501(c)(18)(D) tax-exempt
organization plan.

S 17 — USERRA 2017 make up employee salary reduction contributions under a section 408(p)
SIMPLE.

Y 17 — USERRA 2017 make up deferrals under section 409A nonqualified deferred
compensation plan.

AA 17 — USERRA 2017 make up designated Roth contributions to a section 401(k) plan.

BB 17 — USERRA 2017 make up designated Roth contributions under a section 403(b) salary
reduction agreement.

EE 17 — USERRA 2017 make up designated Roth contributions under a section 457(b) plan.

Print W-2s

Printing W-2s on blank paper enables reconciliation with tax filings before you need to submit the W-2s to
employees and taxing agencies. Deltek recommends that you print W-2s on blank paper and reconcile
them before printing on forms.

Then, print a test run on the form you are using. Five records serve as a good guide to test the alignment.
You may have to try a different printer driver for the alignment to be acceptable.
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You can test alignment at any time after you receive the CYE Regulatory Update and before you need to
print W-2s on the official forms.

- Browse Applications = People = Payroll = Year-End Processing = Print W-2s

=) Identification Mew | Copy W | Deletz 10f 1 New Table | Query W |[]| | X
Parameter D * Description ™
Selection Ranges
Option Start End
Employee Name v Al v ' l [] Mon-Contiguous
Range
Taxable Entity * One l
Payroll Year*® One
Form Type * One -Select- v
Sort By Options
1st Sort 2nd Sort*
Starting Control Number 1
Employee Name None
Employee Name Non-Contiguous Ranges  Employee Non-Contis Ranges Social Security Number Non-Contiguous Ranges  Postal Code Non-Contiguous Ranges

Withholding State Mon-Contiguous Ranges  Organization Non-Contiguous Ranges  Locator Code Non-Configuous Ranges  Mailing State Non-Contiguous Ranges  Locality Non-Configuous Ranges

To print W-2s:
1. Enter the required fields of data, designated with a red asterisk.

2. Select the Non-Contiguous Range check box to allow the various subtasks at the bottom of the
screen to become available for use.

Use the Starting Control No option to enter a starting control number for W-2s.
4. Print W-2s on blank paper and review them carefully before printing them on forms.

= You can sort the W-2s by Employee Name, Social Security Number, Employee ID, Postal
Code, State, Home Org, or Locator Code.

= You can print the W-2s for a single state. When printing the state copies of the W-2s, select
the primary sort of State.

5. If you need to make any adjustments, follow the recommendations in the “Edit W-2s" section,
starting on page 33. Reprint the W-2s on blank paper as many times as needed.

6. Reconcile your quarterly reports with the W-2 Summary Report.

7. When finalized, print the W-2s on the forms and deliver to employees by January 31. If your firm
has a bulk mailing rate, you can print employee copies by postal code.

Maintain Employer copies of the W-2 forms.

Create the file for Federal filing (using the Create Federal W-2 File screen), if applicable, and file
electronically with the Federal Government by February 28.

10. Create the file for State filing (using the Create State W-2 File screen), if applicable, and file
electronically with the appropriate State Government agency. If you are printing W-2s for multiple
states, you can print the employer copies by state.
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Print W-2 Summary Report

% [1 Browse Applications > People > Payroll > Year-End Processing = Print W-2 Summary Report
=3 Identification Maw | Copy W | Delete 10f1 New Table [Query W ]| | X
Parameter ID* Description *
Selection Ranges Options
Option Start
Taxable Entity * One ) ) [ Include Voided W-2s
Payroll Year* One

Use this screen to print the W-2 Summary Report, which summarizes the amounts found on each box of
the W-2s for the entire company.

Sample W-2 Summary Report

Year End Company

1 P 1of2

W-2 Summary Report B

Payroll Year: 2039 0222 PM

Taxable Enﬂ' 10: ACME FRODUCTION

Box 1 Federal Taxable Wages 220,685.03
Bax 2 Federal Income Tax Withheld 50,303.01
Box 3 - Social Security Wages 150,636.56
Bax 4 - Social Security Tax Withheid 27817
Bax 5 - Medicare Wages 225,186.56
Box 6 - Medicare Tax Withheld £0.81
Box 7 - Social Security Tips 0.00
Box 8 - Allocated Tips 0.00
Box 9 - Advance EIC Payment nia
Box 10 - Dependent Care Banefit 50.00
Bax 11 - Nonqualified Plans 0.00
Box 12 - Code A 0.00
Box 12 -Code B 0.00
Box 12-Code C 136.59
Box 12 -Code D 1351.53
Box 12 -Code E 0.00
Box 12 - Code F 0.00
Box 12 - Code G 0.00
Box 12 - Code H 0.00
Box 12 - Code J 0.00
Box 12 - Code K 0.00
Box 12 - Code L 0.00
Box 12 - Code M 0.00
Box 12 - Code N 0.00
Box 12 - Code P 0.00
Box 12 - Code O 0.00
Box 12 -Code R 0.00
Box 12 - Code 5 0.00
Box 12 -Code T 0.00
Box 12 - Code V 0.00
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Box 12 - Code W
Box 12-Code Y
Box 12-Code Z
Box 12 - Code AA
Box 12 - Code BB
Box 12 - Code CC
Box 12 - Code DD
Box 12 - Code EE
Box 12 - Code FF
Box 14 -Line 1
Box 14 - Line 2
Box 14 - Line 3

Year End Company

W-2 Summary Report

Baox 15 - State
Box 16 - State Wages
Box 17 - State Withholding

Box 15 - State
Box 16 - State Wages
Box 17 - State Withhokding

Box 15 - State
Box 16 - State Wages
Baox 17 - State Withhokding

Bax 20 - Locality
Box 18 - Locality Wages
Box 19 - Locality Withholding

Box 20 - Locality
Box 18 - Locality Wages
Bax 18 - Locality Withholding

Bax 20 - Locality
Box 18 - Locality Wages
Bax 19 - Locality Withholding

Box 20 - Locality
Box 18 - Locality Wages
Box 19 - Locality Withholding

Payrol Year 2039

Taxable Enity ID: ACME PRODUCTION

0.00
0.00
0.00
0.00
0.00
0.00
326.94
0.00
0.00
0.00
0.00
0.00

Page 20f2
1231139
0z22 PM

ChA
1,000.00
0.00

MD
1,114.83
0.00

NJ
202,120.20
14,032.21

New Jersey Disability Ins
370.20
0.00

MNJSDI
31,270.20
11257

NJ Uemployement Local Tax
370.20
142

NJ Workforce Dev
201,750.00
0.74
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Manage Tax File Data
Browse Applications > People > Payroll = Year-End Processing > Manage Tax File Data
* @
=3 Identification New Copy ¥  Delele 10f 1 New Table | Query ¥ [] | X
Taxable Entity Code * | qQ )
Preparer Code * [-Select- v
Kind of Employer * [Mone Apply v
Contact Information
Contact Name * Fax
Job Title E-mail *
Phone Number * Extension
Idaho
[] Fed/State Combined 1099 Participant Filing Cycle [-None- v Total 10995

You must set up the Manage Tax File Data screen in Payroll » Year End Processing for each taxable
entity in order to create the W-2 file to be transmitted electronically.

Create Federal W-2 File

The 2018 Calendar Year-End (CYE) Regulatory Update reflects the federal filing requirements as of
October 2018. Any future requirements will be incorporated in the Costpoint software and released in
early January 2019.

Use this screen to create the Federal file for electronic filing after your W-2s are finalized.

% [0 Browse Applications > People = Payroll > Year-End Processing > Create Federal W-2 File

=) Identification New | Copy ¥ | Delete 10 1 New Table | Query ¥ []— X
Parameter ID * Description *

Selection Ranges Sort By

Option 1st Sort

Taxable Entity * One l Employee Name
Payroll Year* One

Options
File Name [] Overwrite File
File Location )

File Data
Farmer EIN
UserID*
WFID Resub

[J Terminating Business

This screen creates the data file W2REPORT.YY where YY represents the payroll year for which the
report is created. You need to rename this data file to the IRS required file name W2REPORT (no
extension).

The Federal W-2 File Report prints automatically each time that you create the W2REPORT.YY file. After
running this program and reviewing the printed report, copy the file exactly as named above (W2REPORT
with no file extension). This is the file that you must send to the Social Security Administration.

Make sure that the file location you select is in a directory to which you have been granted rights. If you
receive an error message such as “file not found,” the file might have been created in a directory to which
you do not have access.
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Create State W-2 File

The 2018 CYE Regulatory Update reflects the state filing requirements as of October 2018. Some states
do not publish their filing changes until mid-November. Any future requirements will be incorporated in the
Costpoint software and released in early January 2019.

* Browse Applications > People > Payroll > Year-End Processing > Create State W-2 File

=3 Identification New  Copy ¥ | Delete 16 1 New Table | Query ¥ |[] — X
Parameter ID * | Description *

Selection Ranges

Option

Taxable Entity * One '

State® One )

Payroll Year* One

Options Sort By
Output File 1st Sort
File Name serwi il
[] Overwrite File Employee Name
File Location )
File Data
RV Record Data

Farmer EIN
Submission Date ol Late Filing Penalty

User ID*
Withholding Paid Interest Due

/

WFID Resub Other Amount Overpayment Handling Method * Apply as Credit

NJ UVHCAWD * Not applicable
Credit Amount MAICS Code

Computer Manufacturer
Balance Due Penalty IA Business eFile Number (BEN}

[] Terminating Business

Third Party Payer FEIN Third Party Payer Amount
Third Party Payer Name /| Complete Filing

The Create State W-2 Files screen creates a data file which you may file electronically.

Some states require the state ID to be in a certain format. Please review the manner in which you have
entered the state taxing ID in State Taxes to be sure that you will comply.

The State W-2 File Report prints automatically each time that you create the W2RPTST.YY file, where ST
represents the two-character state abbreviation code, and YY represents the payroll year for which you
are reporting in this screen. You must rename this data file to the file name required by the state, such as
W2REPORT (no extension). The information included in the file is identical to the printed W-2s.

Puerto Rico

The RS record file layout for Puerto Rico is not supported on the Create State Mag Media screen.

Common Roadblocks/Reconciliation Issues

Dollar amounts on the Earnings Report (or Tax Report) are not
balancing with W-2s.

An edit has been made to the Edit W-2 table and has not been recognized on the Manage Employee
Earnings History screen. Employee Earnings is the source for W-2s and Tax Reporting. Make any
adjustments on the Manage Employee Earnings and History screen and re-create W-2s.
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[ have adjustments that [ have to make for such things as Relocation
Expenses (non-cash fringe), but I won't get the information until the 24
week of January.

You can still create your W-2s and print them to do your reconciliation with your taxes for the information
you currently have. Once that is reconciled, you should be able to identify any adjustments made (Z
records) and not have to start the whole reconciliation process over.

What can I do if I have under- or over-withheld an employee’s Social
Security, Medicare, or withholding and I have already started the
payroll for the next year?

Run the Print Soc Sec and Medicare Reconciliation Report after each payroll. This report identifies any
mistakes in taxable wages and withholdings during the year and allows your quarterly reports to be
correct during the year, thus avoiding amended returns.

If an employee is under-withheld, take one of the following actions:

= Make an agreement with the employee that you will adjust the record (Z record) and have the
employee pay you the dollar amount back as a “loan” in his or her next paycheck. Z records give
you an audit trail that a manual adjustment was done in a given year.

=  Adjust the withholding by taking out of federal and putting in Social Security/Medicare. Deltek
does not recommend this approach.

= Have your company pay the taxes for the employee as a “gross-up” benefit.

If an employee is over-withheld, reimburse the employee with a negative “loan” deduction.
Troubleshooting Tips

Taxable wages on W-2 are incorrect for an employee.

Print the Employee Earnings Report YTD for the employee and review it to see why taxable wages are
incorrect and what type of adjustment you need to make. Also, determine if the adjustment involves a
journal entry to be made to the General Ledger to recognize expense. In addition, if you do an adjustment
record with a check date prior to the fourth quarter, you must re-file your quarterly reports.

The Retirement Plan Covered check box is cleared on W-2 and needs to
be selected.

The Retirement Plan Covered check box was not selected in Employee Payroll Information» Manage
Employee Taxes. You should select that check box and re-create W-2s or select the check box on the
Edit W-2 screen.

['ve done my last payroll of the year, ran my Reconciliation Soc. Sec.
and Medicare Report, and found an employee who owes taxes. My
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employer decides he will pay the taxes for the employee. (The tax the
employer pays now becomes taxable wages to the employee.)

Enter a Z record on the Manage Employee Earnings History screen, with a check date of December 31,
check number of 999999, the dollar amount, and the Social Security and Medicare amounts to withhold,
resulting in a net 0.00 check.

Example
An employee owes $17.20 for Social Security and $3.40 for Medicare.
= Gross up Calculation: 100 - 7.65 =92.35% (6.2% S.S. and 1.45% Med.)
= $20.60/92.35% = $22.30 (Gross pay amount)
=  $17.20 + $1.38 = $ 18.58 (Social Security)*
= $ 340+%0.32=$% 3.72 (Medicare)**
= NetPaynow = 0.00
*$22.30 x 6.2% = $1.38
**$22.30 x 1.45% = 0.32

You can use this calculation for “grossing-up” any amounts an employer may be paying for an employee.
The tax percentage to subtract from 100 will always be equal to the percentage of taxes to be withheld.
You must make a manual journal entry to recognize these transactions.

The same scenario as above occurs, however the employer does not
want to pay the taxes. (Deltek does not recommend this solution.)

= If the payroll year is closed, add a Z record to Manage Employee Earnings History screen that
moves the amount out of federal withholding and places the amount in Social Security and
Medicare withholding. You must make a manual journal entry to recognize this transaction.

= If the payroll year is open, add an X or Y record to Manage Payroll Records that removes the
amount from federal withholding and places the amount in Social Security and Medicare
withholding. Enter the check number and a date before December 31 and then post the payroll
journal.

Any changes made in employee earnings that affect General Ledger also require a journal entry in the
General Ledger module, if you are not posting an X or Y record.

A deduction for an employee 1s not showing up in Box 12.

Select the deduction in Payroll » Deductions » Manage Deductions and link it to the correct Deduction
Type. Then, re-create the W-2.

W-2 information 1s not aligning correctly on the form.

See the Costpoint online help system for printing hints and to verify that your printer set up is correctly. If
not, contact Costpoint Technical Customer Care.
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W-2 Format

Name Description

a. Employee's Social Security Number For security reasons, the Social Security number has
been moved out of the area that is visible when a
window envelope is used to mail the W-2s.

b. Employer Federal ID Number This field defaults from the Configure Company
Information screen in General Ledger.

C. Employer's Name, Address, and Zip These fields default from the Configure Company

Code Information screen in General Ledger.
d. Control Number This box identifies the individual Form W-2.
e. Employee's Name These fields default from the Manage Employee

Information screen.

f. Employee's Address and ZIP Code These fields default from the Manage Employee
Information screen.

1. Wages, Tips, and Other The amount displayed here is the sum of all Federal
Compensation Taxable amounts from the Manage Employee Earnings
History screen. All deferred compensation amounts
(Codes D-H in Box 12) and other Federal exempt pay
types and/or deductions are subtracted from gross
wages to arrive at this amount. Employer contributions
to 401(k) are not part of the calculation.

2. Federal Income Tax Withheld The amount displayed here is the sum of all Federal
Withheld amounts from the Taxes Withheld subtask of
the Manage Employee Earnings History screen.

3. Social Security Wages The amount displayed here is the sum of all Social
Security Taxable amounts from the Manage Employee
Earnings History screen. All Social Security exempt pay
types and/or deductions are subtracted from gross
wages to arrive at this amount.

4. Social Security Tax Withheld The amount displayed here is the sum of all Social
Security Withheld amounts from the Taxes Withheld
subtask of the Manage Employee Earnings History
screen.

5. Medicare Wages and Tips The amount displayed here is the sum of all Medicare
Taxable amounts from the Manage Employee Earnings
History screen.

6. Medicare Tax Withheld The amount displayed here is the sum of all Medicare
Withheld amounts from the Taxes Withheld subtask of
the Manage Employee Earnings History screen.
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Name Description

7. Social Security Tips You must enter an amount here, if applicable.

8. Allocated Tips You must enter an amount here, if applicable. This
amount is not included in boxes 1, 3, 5, or 7.

9. This box is no longer printed on the W-2, since the
Advance EIC payment was eliminated for tax years
beginning after December 31, 2010.

10. Dependent Care Benefits The amount displayed here is the total amount of
withholding, from the Deductions subtask of the Manage
Employee Earnings History screen, for the deduction
code that you identified as a Dependent Care deduction
on the Manage Deductions screen.

11.  Nonqualified Plans The amount displayed here is the total amount, from the
Pay Types subtask of the Manage Employee Earnings
History screen, for the pay type that you associated with
this box on the Manage Pay Type Taxability screen.
This amount is:

= Reported in box 1, if it is a distribution made to the
employee from a nonqualified deferred
compensation or section 457 plan, or

= Included in box 3 and/or 5 if it is a prior year deferral
under a nonqualified or section 457 plan that
became taxable for Social Security and Medicare
taxes this year because there is no longer a
substantial risk of forfeiture of the employee's right
to the deferred amount.

12a— A Uncollected Social Security | The amount displayed here is the amount of uncollected
12d Tax on employee's tips Social Security or RRTA tax on tips.
B Uncollected Medicare Tax The amount displayed here is the amount of uncollected
on employee's tips Medicare tax on tips.
C Excess Life Insurance The amount displayed here is the cost of group-term life

insurance over $50,000 included in boxes 1, 3—up to
the Social Security wage base—and 5.

D Section 401(K) Deferred The amount displayed here is the amount of elective
Compensation Plan deferrals to section 401(k) cash or deferred

arrangement, and also includes deferrals under a
SIMPLE retirement account that is part of a section
401(k) arrangement. The amount shown here is the total
amount of withholding from the Deductions subtask of
the Manage Employee Earnings History screen, for the
deduction code that you identified as 401(k) Deferred
Compensation on the Manage Deductions screen.
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Name Description

D USERRA (2009, 2011- USERRA (2009, 2011-2017) make up elective deferrals
09,11- 2017) make up elective to a section 401(k) cash or deferred arrangement.
17 deferrals to a section 401(k)
cash or deferred
arrangement.
E Section 403 (B) The amount displayed here is the total amount of
Salary Reduction withholding from the Deduction subtask of the Manage
Employee Earnings History screen, for the deduction
Agreement Deferred . -
Compensation Plan code that you identified as 403(b) Defgrred
Compensation on the Manage Deductions screen.
E 09, USERRA (2009, 2011- USERRA (2009, 2011-2017) make up elective deferrals
11-17  2017) make up elective to a section 403(b) salary reduction agreement.
deferrals to a section 403(b)
salary reduction agreement.
F Section 408(K) 6 The amount displayed here is the total amount of
Salary Reduction SEP withholding, from the Deductions subtask of the M_anage
Employee Earnings History screen, for the deduction
code that you identified as 408(k) 6 Deferred
Compensation on the Manage Deductions screen.
F 09, USERRA (2009, 2011- USERRA (2009, 2011-2017) make up elective deferrals
11-17  2017) make up elective to a section 408(k)(6) salary reduction agreement.
deferrals to a section
408(k)(6) salary reduction
agreement.
G Section 457(b) or 457(f) The amount displayed here is the total amount of
withholding from the Deductions subtask of the Manage
Employee Earnings History screen, for the deduction
code that you identified as 457 Deferred Compensation
in the Manage Deduction screen.
G 09, USERRA (2009, 2011- USERRA (2009, 2011-2017) make up elective
11-17 | 2017) make up elective deferrals and employer contributions (including
deferrals and employer nonelective deferrals) to a section 457(b) deferred
contributions (including compensation plan
nonelective deferrals) to a
section 457(b) deferred
compensation plan
H Section 501(C)18(D) The amount displayed here is the total amount of

Tax Exempt Organization
Plan

withholding, from the Deductions subtask of the Manage
Employee Earnings History screen, for the deduction
code that you identified as 501(c) 18(D) Deferred
Compensation on the Manage Deduction screen.
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Name Description

H 09, USERRA (2009, 2011- USERRA (2009, 2011-2017) make up elective deferrals
11-17  2017) make up elective under a section 501(c)(18)(D) tax-exempt organization
deferrals under a section plan.

501(c)(18)(D) tax-exempt
organization plan.

J Nontaxable Sick Pay The amount displayed here is the total amount of
nontaxable sick pay not included in boxes 1, 3, or 5.

K % Excise Tax on excess The amount displayed here is the total amount of
Golden Parachute withholding from the Deductions subtask of the Manage
Payments Employee Earnings History screen, for the deduction

code identified as Golden Parachute on the Manage
Deduction screen.

L Non-taxable Employee The amount displayed here is the total amount of non-
Business Expenses taxable Employee Business Expenses (if taxable
Employee Business Expenses are included in Box 1).

M Uncollected Social Security | The amount displayed here is the total amount of
Tax for Former Employees uncollected Social Security or RRTA tax on cost of
group-term life insurance over $50,000 (former
employees only).

N Uncollected Medicare Tax The amount displayed here is the total amount of
for Former Employees uncollected Medicare tax on cost of group-term life
insurance over $50,000 (former employees only).

P Moving Expenses The amount displayed here is the total amount of
excludable moving expense reimbursements paid
directly to employee (not included in boxes 1, 3, or 5).

Q Non-taxable Combat Pay

R Employer Contributions The amount displayed here is the total amount of
employer contribution to the employee’s medical
savings account (MSA).

S Section 408(P) Plan The amount displayed here is the total amount of
employee salary reduction contributions under a section
408(p) SIMPLE (not included in box 1).

S USERRA (2009, 2011- USERRA (2009, 2011-2017) make up employee salary

09,11- 2017) make up employee reduction contributions under a section 408(p) SIMPLE.

17 salary reduction

contributions under a
section 408(p) SIMPLE.

T Adoption Benefits The amount displayed here is the total amount of
adoption benefits not included in box 1.
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Name Description

Vv Income for exercise of non-  The amount displayed here is the total amount of
statutory stock option(s) income from exercise of non-statutory stock option(s)

included in boxes 1, 3 (up to Social Security wage base)
or 5.

w Health Savings Account The amount displayed here is the total amount of
employer and employee contributions to a Health
Savings Account (HSA).

Y Section 409(A) Deferrals The amount displayed here is the total amount of

deferrals under a section 409A nonqualified deferred
compensation.

Y 09, USERRA (2009, 2011- USERRA (2009, 2011-2017) make up deferrals under
11-17  2017) make up deferrals section 409A nonqualified deferred compensation plan.
under section 409A
nonqualified deferred
compensation plan.

z Section 409(A) Income The amount displayed here is the total amount of
income under a section 409A nonqualified deferred
compensation.

AA Roth 401(K) Contribution The amount displayed here is the total amount of
Plan designated Roth plan contributions under a section
401(k) plan.
AA 09, USERRA (2009, 2011- USERRA (2009, 2011-2017) make up elective deferrals

11-17  2017) make up designated @ to a section 401(k) cash or deferred arrangement.
Roth contributions to a
section 401(k) plan

BB Roth 401(B) Contribution The amount displayed here is the total amount of
Plan designated Roth plan contributions under a section
403(b) plan.
BB 09, USERRA (2009, 2011 USERRA (2009, 2011-2017) make up designated Roth
11-17  2017) make up designated contributions under a section 403(b) salary reduction
Roth contributions under agreement.

section 403(b) salary
reduction agreement

CcC HIRE Exempt Wages and The amount of HIRE exempt wages and tips paid to
Tips qualified employees. Amount must be manually entered.

DD Cost of employer-sponsored The amount displayed here is the cost of employer-
health coverage sponsored health coverage taken from the Deductions

and Contributions subtasks of the Manage Employee
Earnings History screen for Deductions/Contributions
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Name Description

marked as Employer-Sponsored Health Coverage in the
Manage Deductions screen.

EE Designated Roth Designated Roth contributions under a governmental
contributions under a section 457(b) plan
governmental section
457(b) plan

EE USERRA (2011-2017) USERRA (2011-2017) make up designated Roth

11-17 make up designated Roth contributions under a section 457(b) plan.

contributions under a
section 457(b) plan.

13 Retirement Plan Select this box if the employee was an “active
participant” (for any part of the year) in any of the
following.

= A qualified pension, profit-sharing, or stock-bonus
plan described in section 401(a) (including a 401(k)
plan).

= An annuity plan described in section 403(a).

= An annuity contract or custodial account described
in section 403(b).

= A simplified employee pension (SEP) plan
described in section 408(k).

= A SIMPLE retirement account described in section
408(p).

= Atrust described in section 501(c)(18).

= A plan for federal, state, or local government
employees or by an agency or instrumentality
thereof (other than a section 457(b) plan).

14 Other

15 State This box displays the two-character abbreviation from
the Manage Employee Earnings History screen.
Employer's State ID no - The State ID Number as
entered on the State Taxes screen.

16 State Wages, Tips The amount displayed here is the sum of all State

Taxable amounts from the Manage Employee Earnings
History screen. All deferred compensation amounts
(Codes D-H in Box 12) and other State exempt pay
types and/or deductions are subtracted from Gross
Wages to arrive at this amount.
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Name Description

17 State Income Tax The amount displayed here is the sum of all State
Withheld amounts from the Taxes Withheld subtask of
the Manage Employee Earnings History screen.

18 Local Wages, Tips The amount displayed here is the sum of all Local
Taxable amounts from the Taxes Withheld subtask of
the Manage Employee Earnings History screen. Any
SDI information also prints in this box, if setup as a
Local Tax.

19 Local Income Tax The amount displayed here is the sum of all Locality
Withheld amounts from the Taxes Withheld subtask of
the Manage Employee Earnings History screen.

20 Name of Locality This box displays the six-character codes from the
Taxes Withheld subtask of the Manage Employee
Earnings History screen.
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Chapter 6: Closing the General Ledger

Configure General Ledger Settings

% [0 Browse Applications > Accounting > General Ledger = General Ledger Controls > Configure General Ledger Settings

Company Info O—|x
Company * 1 Name* Company 1
Options
& Validate Accounts for Organizations | Update Entry Info when editing a JE Non-Balancing JE's Password * ALLOW
] Post Labor Distribution to GL as Summary Entry [ Posting Validation for FY/Period/Subperiod No of Periods to Keep Open * 3
Retained Earnings Info Functional Currency
I Account 00312 ) FSLine  Current Year Retained Eamnings ) l S0 Code  USD U. 5. Dellar
Other Comprenhensive Income Info Print Journal For
OCI on the Income statement @) Separate Statement of CI @ Labor @ Reference 1 @ Reference 2
Account 00311 ) FS Line Income Taxes Payable )
Data Entry Headings Intsrcompany Receivables Posting Subperiod
Reference 1* REF1 Reference 2* REF2 M Use Maximum Open Subperiod
Update G/L Beginning Balances Defaults Balance Sheet Revaluation Options
) Include Adjustment Periods ] Allow this defaull o be changed in Update process W Creale Revaluation as Net

Corporate Settings ~ Approval Settings

The Configure General Ledger Settings screen determines the Retained Earnings account to which
Income and Expense accounts (determined by the Account Type designated on the Manage Accounts
screen) “close out.” If accounts are designated as Asset, Liability, or Stockholder’'s Equity, they will roll
forward their ending balances to become beginning balances in the new year.

Update General Ledger Beginning Balances

% [0 Browse Applications > Accounling > General Ledger » General Ledger Beginning Balances > Update General Ledger Beginning Balances

= Identification New Copy W | Delete 1 of 1 New Table |Query ¥ [ —| X
Parameter ID* Description *

Selection Ranges

Fiscal Year * 2039 )  Fiscal Year to be Updated 2040 Include Adjustment Periods
Options Sort By
Print Options Show 1st Sort*
[] Print Subiotals (® Changed Balances Only O All Balances [Account ¥
[] Set Fiscal Year Stalus to Closed Closing Rate Type

Use the Update General Ledger Beginning Balances screen:
= To roll forward ending balances of entered year and create beginning balances in the new year.

= All accounts designated with an Account Type of Asset, Liability, or Stockholder’s Equity will
have beginning balances created in the new fiscal year by this process.

= To close the fiscal year.

The Fiscal Year status is changed to Closed only if you select the Set Fiscal Year Status to
Closed check box and set the Closing Rate Type option to Actual or Target.

You can only close the fiscal year if all accounting periods and subperiods in the fiscal year are
set to a Closed status (the Close Periods screen was used to close all accounting periods in the
fiscal year).

You can run this process multiple times, without closing the fiscal year.
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Manage Non-Project Beginning Balances

% [0 Browse Applications = Accounting > General Ledger > General Ledger Beginning Balances > Manage Non-Project Beginning Balances

Fiscal Year/Organization New 1of 1 Existing Table | Query ¥ [ — || X
Fiscal Year*® 2040 ) Organization* Y ) Y Organization )
Amount Hours
Running Balances 501,000.00 0.00
Account Details New | Copy ¥ Form | Query ¥~
v Account * Account Name Proj Required Beginning Amount Beginning Hours
‘00312 CURRENT YRRE N 6,000.00 0.00
‘ 00320 |F‘R\OR YR RETAINED EARNING N ‘ 495000.00 0.00|

Currency Beginning Balances

If the Retained Earnings are separated into two accounts, one for current year and one for prior year,
then you must make a manual entry on the Manage Non-Project Beginning Balances screen for your new
fiscal year (2019).

To make the manual entry:

1. Add the Current Year Retained Earnings Beginning Amount to the Prior Year Retained Earnings
Beginning Amount.

2. Zero out the Current Year’'s Retained Earnings Beginning Amount.

After you complete these steps, your financial statement will appear correctly for the new fiscal year.
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Chapter 7: ‘Closing’/Preparing the Projects Side

Update Prior Year History

1 and Revense Procesaing Ulililien = Update Prios Year History

=5 Identification Mew | Cogy ¥ Doiéta of 8 b Tatie | Guery ¥ | — X

Update Prior Year History creates prior year data for project reporting and revenue calculation. You must
run Update Prior Year History before computing revenue for the new fiscal year; otherwise, revenue may
not create nor appear correctly.

You can run Update Prior Year History multiple times. If at any time, you update or correct the prior year,
you must re-run Update Prior Year History after updating the PSR and creating your Project Report
Tables for the last period in the corrected year.
To complete the Update Prior Year History screen:
1. Enter the Fiscal Year for which you are closing.
2. Select the Update options for the data you wish to make prior year.
= Atthe least, select Project Ledger and Labor History.
= Select Units, if you currently load units for Revenue and/or Billing.
= Select Billing Value, if you currently use Goal Processing functionality.
= Select Cobra History, if you currently interface with the Cobra application.

3. Inthe Update Prior Year History Using group box, select the rates to be used when updating
the prior year history:

= Actual Burden Rates
= Target Burden Rates
= Actual Burden Rates/Target Revenue

4. Inthe Adjustment Period Data to Include group box, select the adjustment period data you
wish to roll to prior year:

a. Adjustment Period is designated on Accounting Period setup. This allows adjustments,
computations, and reporting outside “regular” financial periods

= Cost Only, No Revenue — This allows any revenue calculated in the adjustment period to
remain in the closing year and then be recognized in a future period.

= Both Cost and Revenue — This assumes you have posted the revenue in the closing year
and need the revenue and cost to roll forward.
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= No Adjustment Period Data

5. Inthe Retention of Project Setup Data group box, select the Retention option correct for your
company:
a. This function will copy project setup data to the history tables which allows you to
compute revenue in the prior year using the setup that existed at that time.

b. If history tables exist for a fiscal year, Costpoint will use that saved setup for revenue
computations and project reporting.

= Copy Project Setup Data to History Tables — This process ONLY adds records if they do
not already exist.

= Clear Data From Project History Tables — This process deletes the existing data so that you
can recreate it.

= Overwrite Existing Records — This only allows the process to overwrite existing data with
updated data for the same record.

Copy Pools

= Projects = Cost and Hevesus Processing > Cost and Revesus Processing Ulilties = Copy Posls

-3 Igentification New | Gopy ¥ Duele E— Talo | Guery w [ — (X

Guidelines for the Copy Pools screen:
= Pools must be created every year prior to any billing, revenue, or reporting in the new year.
= Use the Copy Pools utility to copy pools from one year to the next.

=  While Costpoint allows users to copy one pool at a time, it is suggested to copy all pools for the
new year at the same time.

= Inthe Source field, enter the allocation group and fiscal year from which the pools will be copied.

= Inthe Destination field, enter the allocation group and fiscal year to which the pool will be
copied.

= Check the Cancel processing if destination Pool Rate fewer than source box to cancel the
process if the source fiscal year has more periods than the destination fiscal year.
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Cost Pools

& [ Browse Applicalions = Projects =

Identification o0 ¥ fmteg ® b Table Ouery ¥ =%

Allacation Greup* ‘ Primary Alloc | al 7019 | 1
Fool Number * 100 P Frin finge
LECISETTE Defaull Accounts
FediTyoa FRINGE ; & Apply Rates io Prajacts Unalowabls Exclude Burdan fram Asset Invantory
six
Hasis Type
Tiption * Labor & Dollars Hours Units
Financial Reclass Accounts
I Cradit Account I
PoglGost  PoolHase  Servico Centor  Poal Bales
Identification > Pool Rates Maw | Copy w | Deloln  Form | Ouery v (B — |00 %
¥ Penoa'  paaca ViDAchS  PaTarger 10 Target P Provisional Y10 Previnional Pl ol of Mooy ¥I0 Coat of Mooy
12 0.000000% 1 D0000(% 41 000N . 41.000000% 41 500000 0 000000%, 0 o000
n 0.000000% 0.000000% 41 00000% 41.000000% 41.000000% 0000000 L
10 0.000000% 0.000000% 41.000000% 41.000000% 41.000000% 0 000000% 0 O0DON
9 0.000000% 0.000000% 41, 000000% 41.000000% 41.000000% 41.000000% 0 000000% 0 OO0
8 0.000000% 0.000000% £1.000000% 41.000000% 3.000000% 41.000000% 0.000000% 2 00000%
0.000000% 0.000000% £1.000000% 41.000000% 41.000000% 41,000000% 0.000000% 0 00000 v

Clogg

Before computing pools for the new fiscal year, use the Manage Cost Pools/ Pool Rate subtask to
complete the following steps:

1. Zero out the Pd Act and YTD Act columns for all periods.
2. Enter/verify all other columns’ rates.

3. Add lines for all periods in fiscal year.

4. Make any changes to the pool’'s cost and/or base setup.

Provisional rates are used for billing and Target rates can be used for project reporting and Revenue
calculation. Actual rates are computed each period and can be used for project reporting and Revenue
calculation.

Build Rate Application Table

> Cowl Mool Brecwrisg > Buila Mate Applcation Tasie
< |denufication New Copy w  Delate 1l 1 N Tabla Owecy w =l
Paramater 10 * Description *
Iption 1
Al Cne 1 Primary Allocation Group
Fiscal Year* One 2018 I
Poals
Pools Query v ||— [ X
- Sequence Number Pool Number Pool Description
1| 100|ange
1 9999 BARB TEST OH
1 100001 FRINGE
2 200|Overhead
2 100003 Overhead
3 300 General & Administrative
3 100007 General & Administrative
=

The Build Rate Application Table populates the table used to allocate indirect costs to projects. You must
run this process before calculating bills and computing burden in the new fiscal year. Always run this
application after:
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= Creating/changing pools for the new fiscal year
= Changing pool base data

= Changing pool sequence numbers

Manage Burden Cost Ceilings

[ Growse Applications > Prapcts > Project Sslup > Project Calings > Mansde Uerden Cost Callings
= identification Mew | Copy ¥ | Delete . - Tabie | Ouery ¥ |1 X

Projact* -3 I Fiscal Yesr* 2019 ]
Burden Cost Cetling Details MNeew | Copy W | Delete | Foim =
;“ Fune Comol Money e Cesting |

Account s Arzimm K . fool® | pociweme WalwCommg | Format Cotig tommat Method * Apply o RAINA

=N i il i o] o |-Satect [ -alect.
frtmr, of e Lookup to velect, the Bropect, 0% v

If your company uses Manage Burden Cost Ceilings, you must set them up every year because the
ceilings are maintained by project, based on the fiscal year of the pool.

Manage Burden Fee Overrides

* O bw - oy coject Collmgs > Mamag

< identification Now Copy w  Delets [ Table | Cuery w -0 x
Projact* q I

Burden Fee Override Detalls Hew o

v Apptvin |

{1 Poadtiun® | - Bod? ] Brook e | Pewbwrcem | BWAT |

Enter, or wie Lookup to select, the Project. HI00% -

If your company uses the Manage Burden Fee Overrides screen, you must update it yearly because it is
maintained by project, based on the fiscal year of the pool.
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Chapter 8: Closing the Year with Planning

Complete the Costpoint Projects Year-End Processes

Update Prior Year History

Reference “Preparing/Closing the Project Side” in the Year-End Guide.

=5 Identification Hew | Copy v | Delele e 1w Table Guery ¥ [ ™ X

a to Higtary Tablas Clear Data From Project Histary Tables

1. If the prior year data does not exist in the PSR_PY_SUM table, NO ACTUALS will be included for
that Year in reports.

= In Planning, the date on your computer is always current period, so when 1/1/2019 rolls into
your date, 2018 will be treated as prior year.

2. If the Update Prior Year History is incorrectly run so that future year or current year records (that
is, 2019+) now exist in PY_SUM, you will get a PY record in the B&P PSR with a negative value
backing out the amount of those records.

= To correct this, these records will have to be manually removed from Prior Year Cost and
Revenue in Costpoint. Query the records by fiscal year in the Manage Prior Cost and
Revenue screen and delete them.

< |dentification Hew Copy ¥ Dwlele LCEE Table | Ou: v =%

Details. ™

T, or use Lookup to select, s Project. s -
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= When the Update Prior Year Cost and Revenue has been cleared, set the Data Reset Flag
in Configuration Settings to Yes and run the Refresh. This will replace current historical data
with incoming history from Costpoint.

usation Settisgs (MAMTE]

+ Configuration Settings [MAM10) =|x

Separate Subperiods v ] Includa Adjusimant Pariads in Last Sub Parlod
o 5 Ps riad Display
_ & PSR Ravanua Optian Datault

; Select-

ata Pk 100

Enter Dka fesel Flag. 0% v

= The Data Reset Flag does not need to be set back to NO as it auto resets to NO after
Refresh has been run.

Copy Pools

Planning uses the latest Target Rate for current year and future years, it will continue to use the prior
year’s Target rate for Estimates and new budgets until the new year’s Target Rates are entered in
Costpoint and a Refresh has been run.

» Gosl and Revinss Pracessing Utililies = Copy Pools

Niw Copy ¥ Delte Tt 1 tiw Tatie Query ¥ []— X

of lime il @ large amount of dala exisls

Source Destination

2010 ) 7018 )
| I

Gancel processing if destination Pool Rate Data fewer than seurce
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Identification How Copy W | Doleto 1oittamerg | B | M| Table [Quety W] X
Allscation Growp * 4 Primary Aliocation Group | Fircal Yonr® 2014 |
Pool Number * 100 Poal Name * Fringe Fringe
[SECIRVRETEN Cotault Accounts
e
Poal Type FRINGE | & Centar B Apply Rates to Projects ] Unallowable [ Exclude Burden fram Assal Inventory
Basis
Dasis Type
Basls Description Labor & Dollars 7} Hours Units
Financisl Statement Reclass Accounts
Debit Account ] Credit Account ]
Popl Cost  Pool Base  Service Conler | Poul Rales
Mentification > Pool Rates New Copy v Dalets Fom Query v (= — [ X
* P * Pl Al T Achusl Pl T T Target P Parevasiomal VT Prervisicorsad P Ceont o Moy D) Cod of Mereey
2 0.000000% 0 000000% 41.000000% 41,000000% 41.000000% 41.000000% 0.000000% 0.000000%| &
1" 0.000000% 0.000000% 41.000000% 41.000000% 41.000000% 41.000000% 0.000000%
10 0000000% 0000000% 41 000000% 41.000000% 41.000000% 41.000000% o.o00000% | |
] 0.000000%. 0-000000% 41000000% 41, 000000 1.000000% 41.000000% 0.000000%
8 0.000000% 0.000000% 41.000000% 41.000000% 41.0600000% 41.000000% 0.000000%
] 0.000000% 0,000000% 1.000000% 41.000000% 41,000000% £1.000000% 0.000000% ¥

Enter New Calendar Year-End Dates

To enter new calendar year-end dates:

1. Enter the Next Future Year into Costpoint with all the appropriate Period and Subperiod End
Dates.

2. Refresh Planning.

3. Validate that the Period End Dates are correct in “Maintain Fiscal Year Periods”. If they are
incorrect, you can correct them in the Planning “Maintain Fiscal Year Periods”. Once corrected,
the status will change from “FUTURE" to “OVERRIDE".

Maintain Fiscal Year Periads (MAMS, MAME) Mew Copy v | Deolo uery v — ] x

" Fimcal Yaae * Poriod* Sub Period * Cng Date * Guariar®

|+]ama 1 1 010G i
E Tz =h
3 i
4 o IF]
5 2
[ 2
7 3
2 T
& 3
5 = b
" 14
12 1]

Enter 3 vasid date. LM% -

4. When creating an EAC, validate that the End Dates in the headings, for the current year and
future years, are correct. In an EAC, both current year and future year end dates are available to
be seen.
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> Planming > Project Budgeting > BudgeUEAC Processing = Project Buigets | EACs

% [0 Biowse Appiicatins

Project Select

MM13 ) Volume Test

Projact 1D *

Project Budget Status

Creale BUD| Crests EAC| MODIFY] COMMIT| DELETE
r

) [ Include Expi

o=/x

Form | Query ¥

¥| ProjectiD | Type Version  Statss | Source Type SourceVersion || Closed Period Complete Approved Escalstion  StartDate | EndDate  Penods  Cosilype  ProjeciType Level Details Contract fisw _ Funded Rev  Distributed Rev B
[wwaiz— Taup 1 Approved barazo16 =] 7 3.00% 01012016 | 0BBAZ018 32 DIRECT FIKED PRICE  Revi=) Billi=) PLO(=) 300,00000, 150,000 00 ooa |
L) EAC |1 Vorking {BUD I Pann2018 O Lj 3.00% 012016 12312019 3] 48 DIRECT FIXED PRICE Revi=) Bali=) PLC(=) | 300,000.00 150,000.00 0.00
) - >
Sialf Hours  Staff Escalation Malerials  Subconiractor Materisi Handling Travel Consuitant Othe Subcontractor Hours Consultant Hours Service Cenfers Reve =11
" ject La
Project Select > Staff Hours New Copy ¥ Delele Queny v | [=
Project ID: MM13 Type: EAC Version: 1 Status: Working
:J T [HM0I01 0| 0201022819 | DM Y3440 OA01D40048 | DSUOH-0501 18 0SO1.0800°40 | OTAF-07/ 15 0804 063148 | 0N 1)
10 Type * w* Nams * Acct OmiD*  GLCWLC HrRate Rev  Brfl|  gseaiss RN T [ELSTC] [ATE4) (160HED) [176/184) TR (R
| Employes TJEAN Avcher, Darved 05000-001 1.1.100 AT 000 [ % - - - - -
Employee GO0DAS Gootoliow, Alce 05000-010 15100 sA 0wl M M || [T} 0.0 00 [} [} 0o () 0.0
| Empioyes HACK Hack, Martin 05000-010 14,100 85 oo & || 0o 00 0.0 0o 00 00 00 00
k ] e o~
< QIE 3
Employes Schedule Emploves PLC  Advanced Search Fill  Motes
Close

Complete Org Initialization Setup

This process can be completed at any time and for several years in the future. It is not a pre-requisite for
Year End processing. However, it must be completed for the new year before that year's Org Budget can

begin or be reported.

To complete Org Initialization setup:
1. Complete the Holiday Setup for the new year (if not already set up for use in Projects future
years).

> Planning > Gvganization Budgeting » Dudget/Outieck Processing > g,

* @

Organkzation Bucget Cycle Initiakization Header

Orowse Appisations

Source Year* 2018 ] Target Year* 019 ]

Organization Budget Cycle Inialization

Target Yoar 2018

FeGlone Holiday Schedule

Re-Clone Pool Specs |

Re-Freere B

Clone ML Percent Specs

Empleyes Complete

e Specs

MLAb % Spacs

Halidays PTO Patiern  Pocl Bates ool Dase Accl PoplCosiAcel  Emsloves Fates NLAD Parcent Bass  HLAR Percant Tenas

Crganization Hudgnt Cycls Inflinlizatien Hearker > Holidays M | Cogy ¥ | Detete | cuery ¥ | 71| — 1) %
Tangel Fear: 2010
s Holatay * Descrisnon
Tovezenn " M Yoars Day
"5 Gemeres teew Tears Dy
= Momanal Dy
= Indspandanca Day |
Lutor Day |
Tharksateeg Dy |
Chiinimas Dy
Chosy
s -

If using Org Budgets, complete all items in the Org Initialization for the new year. Each item
can be cloned from a prior year. Remember if you have Employee specs and pools setup in
the Target year, you can copy from the same year as the source (that is, from 2019 to 2019.
For Pool specs, copy the 2019 pool information from Costpoint to the 2019 Pool specs in

Planning).
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Organization Budget Cyche Initiakization Header

Organization Budget Cycle Infialization 1001 Exatng Guesy ¥

Re-Cione Hobday Schedule
Clone PTO Patiem |
Re-Clone Pool Specs |

Ree-Freeze Employes Specs

__Clone NL Percent Specs

Camplats

Create Org Budgets for the New year

The budgets for the new year should be set up, if not already entered. These can be entered any time,
even prior to the close of the year.

An example would be, if your budget cycle requires that the org budget be present and reported against
as soon as January 1, then the Org initialization and budgets could be entered any time prior to January 1
of the new year.
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IRS instructions: https://www.irs.gov/pub/irs-pdf/i1099msc.pdf

IRS sample form: https://www.irs.gov/pub/irs-pdf/f1099msc.pdf

9595 []VoID

[ ] CORRECTED

PAYER'S name, street address, city or town, state or province, country, ZIP
or fareign postal code, and telaphone no.

PAYERS TIN RECIPIENTS TIN

1 Rents OMB Mo. 1545-0115
$ 20418 Miscellaneous
e

2 Royalties = Income

% Form 1089-MISC

3 Cther income 4 Federal incomea tax withheld Copy A

$ $ For

5 Fishing boat procssds B Medical and heakh cara payments | Internal Revenue
Service Center

$

$

File with Form 1096,

RECIFIENT'S name

Strest address (including apt. no.)

T Nonemployes compensation

§

8 Substitute payments in lieu of
dividends or interest

§

For Privacy Act
and Paperwork

Reduction Act
Motice, see the

9 Payer made direct sales of |10 Crop insurance proceeds 2018 f_.?ueneral
55-1;3'3 Drmnrz of consumer Instructions for
products to a buyer :

City or town, state or province, country, and ZIP or forsign postal code {recipient] for resele & Ol s Cel"t_El in
11 : = Information
Returns.
Account number (see instructions) FATCA filing| 2nd TIN not.| 13 Excess golden parechute | 14 Gross proceeds paid to an
requirement O payments attomey
= $ $
15a Saction 4094 deferrals 15b Section 4094 incoms 16 Stete tax withheld 17 Stete/Peayer's stafe no. 18 State mcoma

Form 1099-MISC Cat. Mo. 14425]

wrarw.irs.gov/Form1 CO9MISC

Department of the Treasury - Intemal Revenue Sarvics

Do Not Cut or Separate Forms on This Page — Do Not Cut or Separate Forms on Thls Page
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Appendix B: Sample IRS W-2 Form

IRS instructions: http://www.irs.gov/pub/irs-pdf/iw2w3.pdf

IRS sample form: http://www.irs.gov/pub/irs-pdf/fw2.pdf

. a Employes’s social escurity number | For Official Use Only *=
edgaa | ved [ ] OME No. 1545-0008
b Employer identification numbser (EIN) 1 Weages, tips, other compensation 2 Federal ncome tax withheld
¢ Employer's name, eddress, and ZIF cods 3 Social securify wages 4 Social security tax withheld
5 Medicare wages and tips 6 Medicars tax withheld
T Social security tips B8 Allocated tips
d Control number 8 Verification code 10 Dependent care bensfits
& Employes’s first name and initial Last name Suff. | 11 Mongualfied plans 12a Seeinstructions for box 12
W e o e |12 |
14 Crther 12c
12d
f Employes's address and ZIP code
15 it Employers state [0 numbsre 16 State wages, fips, etc. |17 State income tax 18 Local wages, tips, etc. | 99 Local income tax 20 Local®y rems
w-z Wage and Tax Statement Drepartment of tl'!-:- Treasury —Intemal Revenue Sen.-:ce
Form For Privacy Act and Paperwork Reduction
Copy A For Social Security Administration — Sand this antire page with Act Notice, see the separate instructions.
Form W-23 to the Social Security Administration; photocopies are not acceptabla. Cat. No. 101340

Do Not Cut, Fold, or Staple Forms on This Page
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Better software means better projects. Deltek is the leading global provider of enterprise software and
information solutions for project-based businesses. More than 23,000 organizations and millions of users
in over 80 countries around the world rely on Deltek for superior levels of project intelligence,
management and collaboration. Our industry-focused expertise powers project success by helping firms
achieve performance that maximizes productivity and revenue. www.deltek.com
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